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Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being damaged.
Follow these precautions at all times:

Use the power supply voltage specified on the label. Avoid overloading the printer's electrical outlet with
multiple devices.

Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for service,
see Contact HP Support on page 122.

Use only the electrical cord supplied by HP with the printer. Do not damage, cut, or repair the power cord. A
damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-approved
power cord.

Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the
printer. Doing so may cause fire, electric shock, or other serious hazards.

Power off the printer and unplug the power cord from the power outlet in any of the following cases:
—  When placing your hands inside the printer

—  Ifthere is smoke or an unusual smell coming from the printer

—  If the printer is making an unusual noise not heard during normal operation

—  Apiece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of
the printer

—  During an electrical storm (thunder and lightning)

—  During a power failure

HP Start-Up Kit

The HP Start-Up Kitis the DVD that comes with your printer; it contains the printer's software and
documentation.

Using this guide

This guide can be downloaded from the HP Support Center (see HP Support Center on page 120).

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance

These chapters help you carry out normal printer procedures; they include the following topics:

Chapter 1

Connecting the printer on page 12

Setting up the printer on page 19

Personalizing the printer on page 23

Paper handling on page 29

Printing on page 39

Mobile Printing on page 40
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° Practical printing examples on page 48

° Handling ink cartridges and printhead on page 64

° Maintaining the printer on page 68

Troubleshooting
These chapters help you solve problems that may occur while printing; they include the following topics:

° Troubleshooting paper issues on page 84

° Troubleshooting print-quality issues on page 94

° Troubleshooting ink cartridge and printhead issues on page 105

e  Troubleshooting data communication issues on page 107

° Troubleshooting general printer issues on page 114

° Front-panel error messages on page 117

Accessories, support and specifications

These chapters, Accessories on page 79, HP Customer Care on page 119, and Printer specifications
on page 123, contain reference information, including customer care, the printer specifications, and part
numbers for paper types, ink supplies, and accessories.

Glossary

The Glossary on page 128 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer
from being damaged. Follow the instructions marked with these symbols.

AWARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or
death.

A CAUTION:  Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the printer.

Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.

Full name Short name
HP DesignJet T120 24-in Printer T120

HP DesignJet T520 24-in Tabletop Printer T520-24T
HP DesignJet T520 24-in Printer T520-24
HP DesignJet T520 36-in Printer T520-36

ENWW Printer models
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Main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 610 mm (24 in) or
914 mm (36 in) wide. Some major features of the printer are shown below:

e  Print resolution of up to 2400 x 1200 dpi (T520) or 1200 = 1200 dpi (T120), using the Best print-quality
option, the Maximum Detail option and photo paper

e  The printer can be controlled from its front panel or from a remote computer using the Embedded Web
Server or the HP Utility

A,

B NOTE:  Throughout this manual, “HP Utility” refers to the HP Utility for Mac 0S X and the HP DesignJet
Utility for Windows.

e  Touch-sensitive front panel in color, with an intuitive graphical user interface

e  Supports USB, Ethernet, or Wi-Fi connection

e Includes Mobile Printing and Web-connected features such as automatic firmware upgrades and HP ePrint
e  Handles roll and cut-sheet paper, with a multi-sheet tray

° Color emulations, see Printer emulation on page 46

e  Economode for printing economically

e Ink and paper usage information available from the Embedded Web Server, see Access the Embedded Web
Server on page 24

e  Supplies information, troubleshooting, and firmware updates available from the HP Utility, see Access the
HP Utility on page 24

e Access to the online HP Support Center (see HP Support Center on page 120)

Chapter 1 Introduction ENWW



Main components
Front view (T520 except T520-24T)

1. Multi-sheet tray extenders
2. Top cover

3 Output tray extenders
4. Bin

5. Output platen

6. Ink cartridges

7. Ink cartridge cover

8.  Front panel

9.  Printhead carriage

10. Printhead

ENWW Main components 5



Rear view (T520 except T520-24T)

1. Roll cover
2. Communication ports
3.  Power socket

4.  Multi-sheet tray

Rear view (T120 and T520-24T)

1. Bluestop
2. Spindle

3. Paperroll

6 Chapter 1 Introduction ENWW



Communication ports

1. Hi-Speed USB device port, to connect a computer

2. Fast Ethernet port, to connect to a network

Front panel

The front panel is a touch-sensitive screen with a graphical user interface; it is located on the front left of the
printer. It gives you complete control of your printer: from the front panel, you can print, view information about
the printer, change printer settings, perform calibrations and tests, and so on. The front panel also displays alerts
(warning and error messages) when needed.

HP DESIGMNJET

Multi-sheet tray is ready o~ k)

r B 8

Roll Multi-sheet tray Single sheet

The front panel has a large central area to display dynamic information and icons. On the left and right sides you
can see up to six fixed icons at different times. Normally they are not all displayed at the same time.

To the right of the front panel is the power key, with which you can turn the printer on or off. The key is
illuminated when the printer is on. It flashes when the printer is in transition between on and off.

Left and right fixed icons

ENWW

° m shows the status of the wireless connection: if the blue light is shining, the wireless connection is
active.

e  Tap [A] to return to the home screen.

e  Tapg to view help about the current screen.

Front panel



e  Tap[]to go to the previous item.
e Tap[Jto go to the nextitem.
e  Tap &) to go back to the previous screen.

e  Tap [l to cancel the current process.

Home screen dynamic icons
The following items are displayed only on the home screen:

e  Atthe top left of the home screen is a message telling you which paper source is active.

Tap to view Web Services status and display your printer’'s email address.

®  Tap k f}] to view connectivity status information and to perform network configuration. If a network cable

is connected, [ is displayed instead.

[:?’”f’ NOTE: Itis not possible to use wireless and wired network connections simultaneously.

Tap .:I to view ink information.
¢ Tap to change printer settings.

®  Tap G to load, unload, and change options for roll paper.
Tap to change options for the multi-sheet tray, or to activate it.

Tap D to load, unload, and change options for single sheets.

999
[ﬁ' Pl

NOTE: The active paper source is indicated by a slightly larger icon, with a white tick in a green circle: !

J'

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To
change the time that elapses before sleep mode, tap , then Printer preferences > Sleep. You can set a time

between 5 and 240 minutes.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external
interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your printer:
e  The HP-GL/2 and HP RTL driver for Windows (T520 only)
e  The PCL3GUI raster driver for Windows (T120 only)
e  The PCL3GUI raster driver for Mac 0S X

e  HP DesignJet Preview

8 Chapter 1 Introduction ENWW



e The Embedded Web Server allows you to:
—  Manage the printer from a remote computer
—  View the status of the ink cartridges, the printhead, and the paper

—  Access the HP Support Center, see HP Support Center on page 120

- Update the printer's firmware, see Firmware update on page 77

—  Perform alignments and troubleshooting
—  (Change various printer settings
—  Manage e-mail notifications

See Access the Embedded Web Server on page 24.

e  The HP Utility allows you to:
- Manage the printer from a remote computer
—  View the status of the ink cartridges, the printhead, and the paper

- Access the HP Support Center, see HP Support Center on page 120

—  Update the printer's firmware, see Firmware update on page 77

- Launch the Embedded Web Server

See Access the HP Utility on page 24.

[% NOTE: New versions of all printer software can be expected to appear from time to time. In some cases, when
you receive your printer there may already be later versions available on HP's website of some of the software
provided with it.

Mobile Printing

Your printer can be connected to the Internet and the Web, providing various benefits:

e  Automatic firmware updates (see Firmware update on page 77)

e  Print on HP printers from almost anywhere
e  Print on HP printers from almost any device, including smartphones and tablet computers
To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see http://www.hpconnected.com.

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple
steps wherever you are, by using your mobile device OS or sending an email to your printer with a PDF
attachment.

e  i0S-Apple printing is enabled through Airprint.

e  For Android printing, install the HP Print Service App from Google Play (if you do not have it already pre-
installed in your mobile device).

For more information, see Mobile Printing on page 40 and http://www.hp.com/go/designjetmability.

ENWW Mobile Printing
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Turn the printer on and off

If you wish to turn the printer on or off, the normal and recommended method is to use the power key on the
front panel.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are
recommended to unplug the power cord.

L N
When the printer is powered back on, it takes about three minutes to initialize and check and prepare the
printhead. Preparing the printhead takes about 75 seconds.

@ NOTE: When the printer has not been used for a certain period of time (the default time is determined by
Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's front-panel
display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To
change the sleep mode time, see Change the sleep mode setting on page 25.
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The printer’s internal prints

The internal prints give various kinds of information about your printer. They can be requested from the front
panel.

Before requesting any internal print, check that the printer and the paper are ready for printing. The loaded paper
should be at least A4 portrait—210 mm (8.27 in) wide—otherwise the print may be clipped.

To print any internal print, tap , then scroll down to Internal prints and tap it, then select the internal print

you want. The following internal prints are available:
e  Demo prints show some of the capabilities of the printer:
—  Print drawing demo
—  Print rendering demo
—  Print GIS map
e  Userinfo prints
—  Print printer-status report
—  Print print-quality report

—  Print network report

ENWW The printer’s internal prints =~ 11



2  Connecting the printer

e  (hoose which connection method to use

° Connect the printer to your network

e  (Connect a computer to the printer by network (Windows)

e  (Connect a computer to the printer by USB cable (Windows)

e  (Connect a computer to the printer by network (Mac 0S X)

e  (onnect a computer to the printer by USB cable (Mac 0S X)
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Choose which connection method to use

The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

Wireless Moderate; varies according to conditions N/A Sensitive to interference over longer
(distance to router, interference, number of distances; requires extra equipment
wireless clients, network topology, etc.) (wireless access point or wireless router)

Fast Ethernet Fast; varies according to network traffic Long: 100 m (328 ft)  Requires extra equipment (switches)

Hi-Speed USB Very fast Short: 3 m (10 ft) A certified Hi-Speed USB cable is necessary

for reliable communication.

[%”"f NOTE: The speed of any network connection depends on all components used in the network, which can

include network interface cards, routers, switches and cables. If any one of these components cannot operate at
high speed, you will have a low-speed connection. The speed of your network connection can also be affected by
the total amount of traffic from other devices on the network.

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in the
same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front panel:

tap 8 or .

To connect to a wireless network, the easiest way is to go to the front panel and tap , then Connectivity >

Wireless setup wizard.
When a network device automatically configures itself by receiving an IP address from the DHCP service, this IP
address may change from the last time the device is powered off to the next time it is powered on, which may

lead to the device being shown as "offline" when driver port settings are configured with the original IP address.
There are at least three possible ways to avoid this:

e Increase the lease time of your DHCP server device.

e  Setafixed IP address for your printer that will not be changed by DHCP (see Communication failures
between computer and printer on page 108).

° Configure the printer and driver to refer to the hostname instead of the numeric IP address (see
Communication failures between computer and printer on page 108).

See the Assembly Instructions for more details about Internet setup, and how to connect to and register with the
cloud to enable Web Services.

Connect a computer to the printer by network (Windows)

ENWW

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 39 for alternative ways of printing.

Choose which connection method to use
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Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your network
on page 13). The printer can be connected by Ethernet or Wi-Fi.

Now you can proceed to install the printer software and connect to your printer.

Printer software installation

1. Make a note of the printer's IP address from the front panel (see Access the Embedded Web Server
on page 24).

2. Insert the HP Start-up Kit DVD into your computer. If the DVD does not start automatically, run the start.exe
program in the root folder of the DVD.

B NOTE:  You can also download the printer drivers from http://www.hp.com/qo/T120/software or
http://www.hp.com/qgo/T520/software.

3.  Click the Installation tab.

4.  Click the Download button, which takes you to the product page, with the section Software and drivers
already selected.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which
helps you to try to find your printer. If you have a firewall in operation; you may have to disable it
temporarily in order to find the printer. You also have the options of searching for the printer by its
hostname, IP address, or MAC address.

In some cases, when the printer is not in the same sub-net as the computer, specifying the printer's IP
address may be the only successful option.

5. Click the Go button to reach the download page. Your computer automatically reports your operating
system.

6.  Follow the instructions on your screen to install the printer drivers and other HP software, such as the
HP Utility.

If you have enabled Web Services on your printer, you can print to your printer by email. Just check the Web
Services menu for the email address of your printer, then send the file you want to print to that email
address as an attachment.

Connect a computer to the printer by USB cable (Windows)

You can connect your printer directly to a computer without going through a network, by using the printer's built-
in Hi-Speed USB device port. A USB connection may be faster than a network connection, but it has some
disadvantages that you should bear in mind:

e  The cableis of limited length.
e |tis more difficult to share the printer.
e  You cannot use Web Services.

® You cannot use automatic firmware updates.

[%,/r NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB
Implementor's Forum (http://www.usb.ora/) should be used with this printer.
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Printer software installation

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 39 for alternative ways of printing.

1. Do not connect the computer to the printer yet. You must first install the printer software on the computer,
as follows.

2. Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the start.exe
program in the root folder of the DVD.

B NOTE:  You can also download the printer drivers from http://www.hp.com/qo/T120/software or
http://www.hp.com/go/T520/software.

3. Click the Installation tab.

4.  Click the Download button, which takes you to the product page, with the section Software and drivers
already selected.

5. Click the Go button to reach the download page. Your computer automatically reports your operating
system.

6. Insome cases, you may see a message warning you that the installer would need to communicate through
the firewall in order to search the network for printers. As you have no need to do this, you can check the
box Continue installation without searching the network.

7. If yousee a list of networked printers, click Help me find my printer (including network and USB connected
printers).

8.  Click USB Cable.

’L%y NOTE: You can connect your printer and complete the installation later if you prefer. To do so, check the
box marked | want to connect my printer after completing the setup wizard.

9.  When prompted to do so, connect your computer to the printer with a certified USB cable. Ensure that the
printer is turned on.

10. Follow the instructions on your screen to install the printer drivers and other HP software, such as the
HP Utility.

17. If during the process you have not been prompted to connect the printer, connect the printer now, and let
the wizard install the device automatically.

Printer sharing considerations

Any other users sharing your USB-connected printer will be able to send print jobs, but will not be able to receive
information from the printer—which affects status reports, administration and troubleshooting.

% TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the

network. See Connect a computer to the printer by network (Windows) on page 13.

Connect a computer to the printer by network (Mac OS X)

ENWW

You can connect your printer to a network under Mac OS X by using the following methods:
e  Bonjour
e TCP/IP

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 39 for alternative ways of printing.

Connect a computer to the printer by network (Mac 0S X)
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Before you begin, check your equipment:

The printer should be set up and on.
The Ethernet switch or router should be on and functioning correctly.

The printer and the computer should be connected to the (wired or wireless) network. See Connect the
printer to your network on page 13.

Now you can proceed to install the printer software and connect to your printer.

Bonjour connection

1.

10.

Go to the front panel and tap {ffl}J or . Note the mDNS service name of your printer.

Insert the HP Start-up Kit DVD into your DVD drive.

Open the DVD icon on your desktop.

Open the Mac OS X HP DesignJet Installer.

Follow the instructions on your screen.

The printer software is installed, including the printer drivers and other HP software, such as the HP Utility.

If you have enabled Web Services on your printer, you can print to your printer by email. Just check the Web
Services menu for the email address of your printer, then send the file you want to print to that email
address as an attachment.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a
connection to your printer. Follow the instructions on your screen.

When you reach the Select Printer screen, look for your printer's mDNS service name (which you noted in
step 1) in the Printer Name column.

e [fyoufind the right name, scroll sideways if necessary to see the Connection Type column, and check
that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

e |f you cannot find your printer's name with a Bonjour connection type, check the box My printer is not
in the list.

Click Continue.

Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click
Quit to exit, or Create New Queue if you want to connect another printer to the network.

When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

TCP/IP connection
1. Go to the front panel and make a note of the printer's URL (see Access the Embedded Web Server
on page 24).
2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Openthe DVD icon on your desktop.
4.  Open the Mac OS X HP DesignJet Installer.
5. Follow the instructions on your screen.
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The printer software is installed, including the printer drivers and other HP software, such as the HP Utility.

If you have enabled Web Services on your printer, you can print to your printer by email. Just check the Web
Services menu for the email address of your printer, then send the file you want to print to that email
address as an attachment.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a
connection to your printer. Follow the instructions on your screen.

When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1) in the
Printer Name column.

e [fyou find the right name, scroll sideways if necessary to see the Connection Type column, and check
that it shows IP Printing. Then highlight that line. Otherwise, continue searching further down the list.

e Ifyou cannot find your printer's name with an IP Printing connection type, check the box My printer is
not in the list.

Click Continue.

Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click
Quit to exit, or Create New Queue if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

Connect a computer to the printer by USB cable (Mac 0S X)

You can connect your printer directly to a computer without going through a network, by using the printer's built-
in Hi-Speed USB device port. A USB connection may be faster than a network connection, but it has some
disadvantages that you should bear in mind:

The cable is of limited length.
It is more difficult to share the printer.
You cannot use Web Services.

You cannot use automatic firmware updates.

[:?’”r NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB
Implementor's Forum (http://www.usb.ora/) should be used with this printer.

Printer software installation

ENWW

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 39 for alternative ways of printing.

1.
2.

> W

Make sure the printer is either turned off, or disconnected from the computer.
Insert the HP Start-up Kit DVD into your DVD drive.

Open the DVD icon on your desktop.

Open the Mac 0S X HP DesignJet Installer.

Follow the instructions on your screen.

The printer software is installed, including the printer driver and the HP Utility.

Make sure that the printer is turned on and connected to the computer with a certified USB cable.

Connect a computer to the printer by USB cable (Mac OS X)
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A,

B NOTE:  The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the
USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

8.  Shortly afterwards, a print queue is created automatically for your printer.

Sharing the printer

If your computer is connected to a network, you can make your directly connected printer available to other
computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. Toenable printer sharing, click Sharing, then Printer Sharing, and then check the printer(s) that you want to
share.

3. Your printer now automatically appears in the list of shared printers displayed by any other computer
running Mac 0S X and connected to your local network.

Bear in mind the following considerations:
e  Any other users wishing to share your printer must install the printer software on their own computers.

e Anyone sharing your directly connected printer will be able to send print jobs, but will not be able to receive
information from the printer—which affects alerts, status reports, paper management, administration and
troubleshooting.

e  You may find that sharing your directly connected printer with other users will slow down your computer
unacceptably.

{* TIP:  The best way to share the printer over a network is to connect the printer not to any computer, but to the
network. See Connect a computer to the printer by network (Mac OS X) on page 15.
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Setting up the printer

° Introduction

e  Automatic firmware update

e  Turn email notifications on and off

e  Turnalerts on and off

° Control access to the Embedded Web Server

° Set Windows driver preferences

e  Setup Web Services and Mobile Printing

19



Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon as a

new printer is assembled and ready for use.

Automatic firmware update

The printer can automatically check for a firmware update periodically (see Firmware update on page 77).

Without an update, some Web Services may not be available. The Enable Web Services process includes the

option to turn on automatic firmware updates from the printer's front panel or Embedded Web Server.

Turn email notifications on and off

In order to receive email notifications from the printer, you must have configured the email server. To configure
the email server using the Embedded Web Server, click Settings > Email server, and fill in the following fields:

e  SMTP server: The IP address or hostname of the outgoing mail server (SMTP) that will process all email
messages from the printer. If the mail server requires authentication, email notifications will not work.

e  Printer email address: Each email message sent by the printer must include a return address, which does
not need to be a real, functional email address, but it should be unigue, so that recipients of the message

can identify the printer that sent it.

You can turn specific email notifications on or off by clicking Notifications from the Tools tab of the Embedded

Web Server.

Turn alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of your
printing jobs changes its status. The alerts are displayed by the printer's front panel, by the HP Utility, by the

printer driver and by the Embedded Web Server.

You can change the alert settings in various ways to display all, some, or none of the available alerts.

To access alert settings under Windows
e  (lick Alert Settings in the Tools menu of the HP DesignJet Utility.
e  C(lick Alert Settings in any alert page displayed by the HP DesignJet Utility.

e  Right-click the system tray icon of the HP DesignJet Utility, and click Alert Settings.

In the Alert Settings window, you can use the Alerting slider to turn off alerts completely.

&= HP Designjet Litility - Alert Settings =
ﬁp Alert Settings

Alert Setfings by Printer:
changa satiings
The aleri netifications for this printer are INACTIVE. Mo alers will be displayed by your computer.

Critical aleris: | Always

Non-critical alerts: | While priniing

ooy J|Conad |

Alternatively, you can choose when, if ever, to display critical or non-critical alerts.
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&= HP Designjet Utility - Alert Settings X

ﬁp‘ Alert Settings

Alert Setfings by Printer: s
O
The olert narficarions for his priner are ACTIVE, Alertdiclogs of he fallowing typa vl be displayed on your computer.
Critical dlerts: [ Abways -
Noncric s
(Moo |

To access alert settings under Mac OS X

e  (Open HP Printer Monitor preferences, select your printer, and then Customize Alerts, so that you can set
each individual alert to appear in specific cases and with a specific time interval.

(1% ‘ (+ER o] a

Nam  Reload Details

ULl Customize Alerts

Connectiol
P Addres  TUrn Monitoring Off
FW Versiol >
v Diagnose
Serial Numbe ‘
Diagnose Al il

Update Rules & Diagnose All

Go to HP Utility

You can turn off alerts completely by unchecking the “Show monitor status in menu bar” box in the Notifications
tab of the HP Printer Monitor preferences. If you leave that box checked but uncheck the “Notify me when alert
appears” box (as below), the alerts will be available in the HP Printer Monitor, but will not pop up in the Dock

screen.

ann Preferences
L) @ [
General Monitoring | Notifications

Eshow monitor status in menu bar

O Notify me when alert appears
=) All
Critical only
Custom

Fatal

Error
Warning
Information
Optimization

List alerts in popup window
Notified only
=) All active

Control access to the Embedded Web Server

To prevent users from modifying important device settings, you can set a password in the Embedded Web
Server, so that users without the password can see only the Information tabs. Once set, the password is required
to view or change any parameters in the other tabs.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to
set color emulation or paper-saving options. To do this under Windows 7, for example, click the Start button on
your computer's screen, then click Devices and printers, then right-click your printer's icon and click Printing
preferences. Any settings you change in the Printing Preferences window will be saved as default values.
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Set up Web Services and Mobile Printing

1. Make sure that your printer is correctly connected to the Internet.

2 Enable Web Services during initial setup of the printer, or later by tapping pm, on the home screen and

following the instructions on the front panel. The printer may need to restart if it has updated its firmware.

3. Optional step: Activate your account by clicking the activation link that you will receive by email. If you don't
see the message, remember to check your junk email folder.

4.  Optional step: If you are the printer administrator, log in at HP Connected (http://www.hpconnected.com) to
customize your printer's email address or manage printer security for remote printing.

Congratulations, you have completed Web Services setup, and you can benefit from automatic firmware updates.

For the latest HP Connected information, support, and terms of use, see http://www.hpconnected.com.

For more information, see http://www.hp.com/go/designjetmaobility.
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Personalizing the printer

Change the language of the front-panel display

Access the Embedded Web Server

Change the language of the Embedded Web Server

Access the HP Utility

Change the language of the HP Utility

Change the sleep mode setting

Change the auto-off setting

Change the front-panel display brightness

Configure network settings

Manage printer security

Change your printer’s email address

23



Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages:

If you can understand the current front-panel display language, tap , then Printer preferences > Select

language.

e [fyou cannot understand the current front-panel display language, start with the printer powered off. Press
the power key to turn it on. When you see icons appear on the front panel, tap f@&), then [, then f&}, then
. If you cannot see those icons on the front panel, tap where they should appear (see Front panel
on page 7).

Whichever method you used, the language selection menu should now appear on the front-panel display. Tap
your preferred language.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser running
on any computer.

To access the Embedded Web Server, you must have a TCP/IP connection to your printer. You can access the
Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a TCP/IP connection
(wired or wireless).

The following browsers are known to be compatible with the Embedded Web Server:
e Internet Explorer 7 and later

e (Opera8andlater

e  Mozilla Firefox 2 and later

e  Safari3and later

e  Google Chrome 3 and later

To access the Embedded Web Server on any computer, open your Web browser and type the IP address of your
printer.

You can see your printer's IP address on the front panel by tapping [ or k4 ?}]

If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot access
the Embedded Web Server on page 116.

Change the language of the Embedded Web Server

The default language in which the Embedded Web Server first appears is the language you have selected for
your browser. If this language is not supported by the Embedded Web Server, the Embedded Web Server will
appear in English; however, you can change it to any supported language.

The languages supported by the Embedded Web Server are English, Portuguese, Spanish, French, Italian,
German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. There is a tab at the top
right of the window to select language.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP, or Wi-Fi connection.
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Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs > HP >
HP DesignlJet Utility > HP DesignJet Utility. This launches the HP DesignJet Utility, showing the HP DesignJet
printers installed on your computer.

Under Mac 0S X, launch the HP Utility from your dock shortcut or by clicking STARTUP_DISK > Library >
Printers > HP > Utilities > HP Utility. This launches the HP Utility, showing the HP DesignJet printers installed
on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only),
French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Under Windows, the language will be adjusted to your regional language settings as defined in the
Windows Control Panel.

Under Mac 0S X, the language is changed as for any other application. In System Preferences, click
International and re-launch the application.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode to
save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and tap

, then Printer preferences > Sleep. Select the wait time you want and then tap OK; you can set the time

from 5 to 240 minutes. The default time is 30 minutes.

Change the auto-off setting

You can use the printer's auto-off feature to turn the printer off automatically. For example, setting it to 2 hours
would turn the printer off after 2 hours of inactivity. In this way, you can save more energy. However, the auto-off
feature is automatically disabled when the printer is connected to a network, to avoid inconveniencing network
users.

If you are using a USB connection, you can set the printer to turn itself off completely after 2 to 12 hours of
inactivity. At the front panel, tap , then Printer preferences > Auto-off.

Change the front-panel display brightness

ENWW

To change the brightness of the front-panel display, tap , then Printer preferences > Display brightness, and

select a value you want. Tap OK to set the value. The default brightness is set to 50.

Change the language of the HP Utility
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Configure network settings

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front
panel:

e  From the Embedded Web Server: Click the Setup tab, then Networking.

e  From the HP Utility: You can access the Embedded Web Server through the HP Utility.

From the front panel: Tap , then Connectivity.

The following options are available:
e  Enable/Disable wireless turns the wireless connection on or off.
e  Wireless setup wizard provides an easy way to connect to a wireless network.

e  Wi-Fiprotected setup allows you to set up a connection with a wireless network using WPS (pushbutton or
pin) encryption.

e  Network summary displays information about the wired or wireless network
e  Print wireless network test runs diagnostic tests of wireless connectivity

e  Print network configuration

e  Advanced setup

—  Select I/0 timeout sets the time that the printer will wait for the driver to send a job to the printer
once the connection has been opened. Values range from half a minute to half an hour.

—  Link speed sets the speed at which data are transmitted over the network. The default is Automatic.

— [P settings allows you to view or change the IP address, subnet mask, default gateway, and DNS
address.

—  Hostname allows you to change the hostname.

e  Restore network defaults

Configure firewall settings

Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall provides simple
control of IP addresses that are allowed access.

[%r NOTE: In addition to firewall protection at the network layer, the printer also supports open secure sockets

layer (SSL) standards at the transport layer for secure client-server applications, such as client-server
authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP traffic. Firewall
policy pages are accessed through the Embedded Web Server and displayed by your Web browser. After a policy
is configured, it is not activated until you click Apply in the Embedded Web Server.

Creating and using firewall rules

26

Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP traffic based on IP addresses and
services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for those
addresses and services.
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Create a firewall rule
1. Openthe Embedded Web Server.
2. C(lick the Settings tab, then Firewall Rules.

3. Click New, and then follow the onscreen instructions.

[%”f NOTE: After you click Apply, the connection to the Embedded Web Server might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Change the priority of firewall rules
1.  Openthe Embedded Web Server.

2. Click the Settings tab, then Firewall Rules Priority.

3. Select the priority from the Rule Precedence list, with 10 having the highest priority and 1 having the lowest

priority.
4.  Click Apply.
Change firewall options
1.  Openthe Embedded Web Server.
2. Click the Settings tab, then Firewall Options.

3. Change whatever options you wish, then click Apply.

[%”f NOTE: After you click Apply, the connection to the Embedded Web Server might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Reset firewall settings

To reset the firewall settings to the factory defaults, restore the printer's network settings.

Limitations to rules, templates, and services

When creating firewall rules, note the following limitations to rules, templates, and services.

Item Limit

Maximum number of rules 10 (one default rule)
Maximum number of Address Templates 12

Maximum number of user-defined address templates 5

Maximum number of services you can add to a user-defined service template 40

NOTE: The predefined All Services template is not subject to this limitation and includes all services
supported by the print server.

Maximum number of services you can add to the policy 40

NOTE: For a given rule, only one address template and one service template can be added.

Maximum number of service templates in the policy 10

Maximum number of user-defined custom service templates 5

ENWW Configure network settings
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Reset network settings

To reset the administrator password and network settings, go to the front panel and tap , then Connectivity
> Restore network defaults.

[%r NOTE: Print the network configuration page and check that the network settings have been reset.

993

[ NOTE: Resetting the printer’s network settings also resets the printer’s firewall settings.

Manage printer security

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your
printer's email address can print to your printer by just sending a file to it. Although HP provides a spam filtering
service, you should be careful about giving out your printer's email address, as everything sent to that address
may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status to lock mode
by visiting HP Connected at http://www.hpconnected.com (availability varies by product, country, and region).
You can also customize your printer's e-mail address and manage print jobs from there. On your first visit, you
will need to create an account at HP Connected.

Change your printer's email address

You can change your printer's email address at HP Connected: http://www.hpconnected.com (availability varies
by product, country, and region).
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General paper-loading advice

You can load paper into the printer in three different ways: from a roll, as a single sheet, or as a stack of single
sheets from the multi-sheet tray. Only one of these methods can be used at a time, and switching from one to
another is manual: it is not done automatically.

A CAUTION:  Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from
moving.

A CAUTION:  All paper must be 280 mm (11 in) or wider. A4 and letter paper should not be loaded in landscape
orientation.

X TIP:  For photo paper wear cotton gloves to avoid transferring oils onto the paper.

i

A CAUTION:  Keep the bin closed throughout the loading process.

Load a roll onto the spindle

1. If your printeris a T520, open the roll cover.
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2. Remove the spindle from the printer.

AWARNING! Do not insert your fingers into the spindle supports during the removal process.

3. Thespindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a
new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the
end of the spindle.

4. Iftherollis long, rest the spindle horizontally on a table and load the roll on the table.

5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the
roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the
correct orientation.

@ NOTE: From the back of the printer, the blue stopper is inserted into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.

ENWW Load a roll onto the spindle
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6.  Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes. Check that there is no space between the roll and
the stops at both ends.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of
different paper types on different spindles. Extra spindles are available for purchase, see Accessories

on page 79.

Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle on page 30.

1. From the front panel, tap B then Load roll.

This step is optional: if you just start feeding in roll paper, the printer recognizes that you want to load a roll.

2. Ifyour printeris a T520, open the roll cover.

3. Insert the spindle into the printer, holding it by both ends. The blue hub should be on the left, as viewed
from the front of the printer.
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4.  If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the
paper slightly and cut a straight edge.

5. Insert the edge of the paper into the printer.

AWARNING! Do not push your fingers inside the printer's paper path.

A

6.  Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it beeps, and feeds in the paper automatically.

7. The front panel prompts you to select the paper category and type.

Roll - Paper type
® Plain paper

Advance photo

Transparency

HP Bright White IJ Paper

More paper types Continue

If you do not see your paper type in the front panel, tap More paper types. If you still cannot find your paper
type in the whole list, see Paper type is not in the driver on page 87.

8.  The printer checks the alignment and measures the width. If the roll is not correctly aligned, follow the
instructions on the front-panel display.

9. If your printeris a T520, close the roll cover.

[% NOTE: If you have an unexpected issue at any stage of the paper loading process, see Paper cannot be loaded
successfully on page 85.
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Unload aroll

If there is paper on the roll, you can unload it from the front panel: tap , then Unload roll. Afterwards, the
multi-sheet tray will become the default active paper source.
If the end of the paper is no longer attached to the core, the front panel asks you to unload the roll manually.

After unloading, the multi-sheet tray is the default active paper source.

Load a single sheet

99

B NOTE: Roll paper and single sheets use the same input slot in the printer.

E%f NOTE: Sheets of width 329 mm (12.95 in) or less should be loaded from the multi-sheet tray.

1. At the front panel, tap D then Load single sheet.

2. Ifarollis already loaded, you have to wait while it is automatically unloaded.

3. Select your paper category and type. If you do not see your paper type in the front panel, tap More paper
types. If you still cannot find your paper type in the whole list, see Paper type is not in the driver
on page 87.

4.  Ifyour printeris a T520, open the roll cover.

5.

4

e 4
A WARNING! Do not push your fingers inside the printer's paper path.
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6.  Align the sheet with the blue line.

7. Tap OK on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is
especially important with thicker papers.

8.  The printer checks the alignment and measures the sheet.

l%f NOTE: Depending on the width of the sheet, it feeds out the front of the printer.

9. If the sheetis not correctly aligned, you may be asked to reload it.

[%”f NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper cannot be
loaded successfully on page 85.

Unload a single sheet

To unload a sheet, go to the front panel and tap , then Unload single sheet.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the bin.

After unloading, the multi-sheet tray is the default active paper source.

Use the multi-sheet tray

1. Ifnorollis loaded or the roll has run out of paper, the multi-sheet tray is active by default.

Alternatively, at the front panel, tap E then Use multi-sheet tray. If a roll or single sheet is already

loaded, you have to wait while it is automatically unloaded.

2. Adjust the input tray extensions depending on the length of the paper: the first extension for A4 and the
second extension for A3 paper.

ENWW Unload a single sheet
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3.

4.  Load sheets of paper into the tray with the printed side facing outwards. Ensure that the sheets are all of
the same size.

5. Adjust the tray to fit the width of the paper.
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View information about the paper

To view the loaded paper information, tap the icon of the active paper source.
The following information is displayed on the front panel:

e  Paper type you have selected

e  Roll or sheet status

e Width of the paper in millimeters (estimated)

If no roll and no single-sheet paper is loaded, the message Out of paper is displayed.

Maintain paper
To maintain paper quality, follow the recommendations below:
e  Store rolls covered by another piece of paper or cloth

e  Store cut sheets covered and clean or brush them before loading them in the printer
e  (leaninput and output platens

e  Always keep the top cover of your printer closed

[% NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 100.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where
time is of higher importance or when you need to be sure ink is dry before handling.

Tap , then Printer preferences > Print retrieval > Select drying time. You can select:

e  Extended, to set a longer than recommended time to ensure ink is completely dry
e  Optimized, to set the default and recommended time for your selected paper (this is the default setting)

e None, to disable the drying time and remove your print as soon as it finishes printing

A CAUTION:  If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the
print.

E;? NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to
the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then
performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the
paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off, go to the front panel and tap , then Printer preferences > Print
retrieval > Enable cutter and change the cutter option.

The default setting is On.

[% NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on
loading and unloading rolls.
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X TIP: To cut roll paper while the automatic cutter is disabled, see Form feed with or without cutting
on page 38.

Form feed with or without cutting

If you go to the front panel and tap , then Form feed and cut, the printer advances the paper and makes a

straight cut across the front edge. There are at least two possible reasons why you might want to do this:
e  To trim the leading edge of the paper if it is damaged or not straight.

e Tofeedand cut the paper when the automatic cutter has been disabled.

[%’ NOTE: The printhead is serviced after each print, and the paper cannot be cut until the process completes, so
you may notice a delay.

A CAUTION: Remove the cut piece from the output platen. If strips or short prints are left on the output platen,
the printer could jam. Check also that there are no pieces of paper in the cutter guide.

[% NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 100.

To advance the paper without cutting it, go to the front panel and tap , then Form feed.

38 Chapter 5 Paper handling ENWW



6

ENWW

Printing

Mobile Printing

—  Print from mobile devices

—  Print by email (HP ePrint)

Print with HP Click

Printing from a computer using a printer driver

—  Advanced print settings

—  Color management

39



40

Mobile Printing

You can print to your printer from many mobile devices and from almost any location. There are two main
methods of Mobile Printing:

e  Direct printing by connection to the same network

e  Printing by e-mail

Print from mobile devices

You can print directly from the operating system of your mobile device, if your mobile device and printer are
connected to the same network.

For more information, see http://www.hp.com/go/designjetmobility.

Print from Apple iOS
i0S printing is enabled through Airprint. You must have i0OS 7.0 or later.
1. Open the document or photo you want to print, and tap the Share button.
2. Swipe the screen to reveal the Print button, and tap it.

3. Check the print settings, then tap Print.

Print from Android

For Android printing, install and enable the HP Print Service App from Google Play (https://play.google.com/
store/apps/details?id=com.hp.android.printservice&hl=en), if it is not already installed in your device. You must
have Android KitKat 4.4 or later.

1. Open the document or photo you want to print, and tap the menu icon, then Print.
2. Choose your printer from the list.

3. Check the print settings, then tap Print.

Print from Apple iOS or Android with All-in-One Remote

You can download All-in-One Remote from the Apple Store (https://itunes.apple.com/us/app/hp-all-in-one-
printer-remote/id469284907?mt=8) or from Google Play (https://play.google.com/store/apps/details?
id=com.hp.printercontrol&hl=en).

1. Open the document or photo you want to print, tap the Share button, and select AiO.
2. Openitin All-in-One Remote. Go to Settings to adjust the print quality or color mode if necessary.

3. Check the print settings, then tap Print.

Print by email (HP ePrint)

After you have enabled Web Services in the printer (see Set up Web Services and Mobile Printing on page 22), you
can print to that printer by email. Just check the Web Services menu or the ePrint menu for the email address of
your printer, then send the file you want to print to that email address as an attachment.
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In this way, you can print from anywhere with an Internet connection and email capability, without needing any
printer driver. There are a few constraints that you should bear in mind:

e  The attached files to be printed must be in PDF, JPEG, or TIFF formats.
e  The maximum file size is 10 MB, but your email server may have a lower limit.

e  Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in
portrait orientation (some printers may offer autorotation)..

For more information, see https://www.hpconnected.com.

Print with HP Click

You can use HP Click to print a TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer.
See http://www.hp.com/go/clickDesignJet.

Printing from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the
computer (see Connecting the printer on page 12), and the computer must be connected to the printer by
network or USB cable.

When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

Advanced print settings

The rest of this chapter explains the various print settings that you can use. These methods offer a relatively
large number of settings in order to satisfy all requirements.

% TIP:  In general you are recommended to use the default settings unless you know that they do not meet your
requirements.

TIP:  If youintend to reuse a particular group of settings repeatedly, you can save those settings under a name
of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the Windows
printer driver.

Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while
fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed.
With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal, and Fast. If you select Fast, you can also
select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases printing
speed even further, but reduces print quality. Economode can be selected only from the custom options (not
from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See
High-quality printing on page 45.

[%Nf NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print
Quality Options dialog box (click Custom options and then Settings). In the Mac OS X Print dialog, it is displayed in
the Summary panel.
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You can select print-quality options in the following ways:

In the Windows driver dialog: Click the Paper/Quality tab and look at the Print Quality section. If you click
Standard Options, you will see a simple slider with which you can select speed or quality. If you select
Custom Options, you will see the more specific options described above.

In the Mac 0S X Print dialog: Click the Paper/Quality panel and look at the Quality Options section. If you
select Standard quality options, you will see a simple slider with which you can select speed or quality. If
you select Custom quality options, you will see the more specific options described above.

[%]’9 NOTE: You cannot change the print quality of pages that the printer is already receiving or has already received
(even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

[%r NOTE: The paper size specified here should be the paper size in which the document was created. It is possible
to rescale the document to a different size for printing. See Rescale a print on page 44.

In the Windows driver dialog: Click the Paper/Quality tab, then select your paper size from the Document
Size list.

In the Mac 0S X Page Setup dialog: Select your printer from the Printer list, then select your paper size from
the Paper Size list.

[:?’”f NOTE: If your application offers no Page Setup dialog, use the Print dialog.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various
different ways to specify it.

Use the Windows printer driver

1.
2.
3.
4,

Click the Paper/Quality tab.
Click the Custom button.
Enter the name and dimensions of your new paper size.

Click OK. The new paper size is automatically selected.

A custom paper size created in this way has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

The paper size is local to the printer gueue. It will not be seen from other printer queues in the same
computer.

In Domain server networks, the paper size is local to the computer. It will not be seen from other
computers sharing the printer queue.

In Workgroup networks, the paper size will be shared among all the computers sharing the printer queue.

If the printer queue is deleted, the paper size is deleted with it.
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Use Windows forms

1.

> W

6.
7.

Windows Vista or XP: From the Start menu, or from the Control Panel, click Printers; then, from the File
menu, click Server Properties.

Windows 7: From the Start menu, or from the Control Panel, click Devices and Printers, then Select Printer.
In the Forms tab, check the Create a new form box.

Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

Click the Save Form button.

Go to the printer driver, and click the Paper/Quality tab.

Select More... from the drop-down list of paper sizes.

Select your new paper size from the group of Custom sizes.

A custom paper size created in this way has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

Restricted users cannot create paper forms. The “manage documents” role in the Windows Active Directory
is the minimum required.

The paper size is local to the computer. It will be seenin all the printer queues that have been created on
the computer and that support paper of that size.

If a printer queue is shared, this paper size will appear in all the client computers.

If a printer queue is shared from another computer, this paper size will not appear on the driver s
document size list. A Windows form in a shared queue needs to be created in the server.

If the printer queue is deleted, the paper size is not deleted.

Use the Mac OS X printer driver

1.

2.

Go to the Page Setup dialog.

r_ﬁ”f NOTE: If your application offers no Page Setup dialog, use the Print dialog.

Click Paper Size > Manage Custom Sizes.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper.
However, you can change this behavior in the following ways:

In the Windows driver dialog: Click the Paper/Quality tab and then the Margins/Layout button.

In the Mac 0S X Print dialog: Click the Margins/Layout panel.

You will then see at least some of the following options.

[ NOTE:  Under Mac 0S X, the available margins options depend on the paper size selected.
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e  Standard. Your image will be printed on a page of the size you have selected, with the default margin
between the edges of the image and the edges of the paper. The image should be small enough to fit
between the margins.

e  Qversize. You should load paper that is larger than the size you selected in the application or driver. If you
cut off the margins after printing, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper. This is useful when you want your image to
cover the whole area of the paper.

e  (lip Contents By Margins. Your image will be printed on a page of the size you have selected, with the
default margin between the edges of the image and the edges of the paper. In this case, if the image is the
same size as the page, the printer assumes that the extreme edges of the image are either white or
unimportant, and do not need to be printed. This may be useful when your image already contains a
border.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your printer
driver.

e |nthe Windows driver dialog: Click the Paper/Quality tab, then select Any in the Paper Type drop-down list.

e Inthe Mac 0S X Print dialog: Click the Paper/Quality panel, then select Any in the Paper Type drop-down list.

EY NOTE:  Any s the default Paper Type selection.

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally
larger). This may be useful:

e  [fyour software does not support large formats

e Ifyourfileis too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:
e Inthe Windows driver dialog: Click the Features tab and look at the Resizing Options section.

—  The Print document on option adjusts the image size to the paper size you have selected. For
example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged
to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4
size.

—  The % of actual size option enlarges the printable area of the original paper size (the page minus the
margins) by the percentage indicated, then adds the margins to create the output paper size.

e  Inthe Mac 0S X Print dialog: Click the Paper Handling panel, then Scale to fit paper size, and select the
paper size to which you want to scale the image. If you want to increase the size of the image, make sure
that the Scale down only box is unchecked.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the
image will be clipped.
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Print a draft
You can specify fast draft-quality printing in the following ways:

e |nthe Windows driver dialog: Click the Paper/Quality tab and look at the Print Quality section. Move the
print-quality slider to the extreme left (‘Speed').

e Inthe Mac 0S X Print dialog: Click the Paper/Quality panel and move the print-guality slider to the extreme
left ('Speed).

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for
documents containing only text and line drawings:

e Inthe Windows driver dialog: Click the Paper/Quality tab and look at the Print Quality section. Click Custom
Options, then set the quality level to Fast and check the Economode box.

e Inthe Mac OS X Print dialog: Click the Paper/Quality panel and set the quality options to Custom, then set
quality to Fast and check the Economode box.
High-quality printing
You can specify high-quality printing in the following ways:

e Inthe Windows driver dialog: Click the Paper/Quality tab and look at the Print Quality section. Move the
print-quality slider to the extreme right (‘Quality’).

e Inthe Mac 0S X Print dialog: Click the Paper/Quality panel and move the print-quality slider to the extreme
right (‘Quality’).
If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail option.
This option is available only if you are printing on glossy paper and you have selected Best print quality.

e Inthe driver dialog (Mac OS X Print dialog): Select Custom instead of Standard print-quality options, then
check the Maximum Detail box.

[%r NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the
amount of ink used.

Use paper economically
You may be able to save some roll paper by using the following options:

e Inthe Windows driver dialog: Click the Features tab and then Remove top/bottom blank areas and/or
Rotate by 90 degrees or Autorotate.

e Inthe Mac OS X Print dialog: Click the Finishing panel, then Remove Top/Bottom Blank Areas.

Use ink economically
Here are some recommendations for making economical use of ink:

e  Fordraft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed'). For
further economy;, select custom print quality options, then select Fast and Economode.

e  (lean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small amount of
ink.
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e  Leave the printer permanently turned on so that it can maintain the printhead in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done,
the printer may need to use much more ink later to restore the health of the printhead.

e  Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some
ink, and its frequency is related to the number of passes made by the printhead.

Color management

Your printer has been engineered with advanced hardware and software features to ensure predictable and
dependable color results:

e  State-of-the-art HP printheads and HP inks
e  Dedicated color resources for most available paper types

e  C(Color emulation of other HP DesignJet printers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you
print an image, you see very similar colors as when you view the same image on your monitor. Color
management is highly dependent on the paper type loaded at the printer, so take care to select the correct
preset for the paper type you are using.

The color management options for your printer can be selected from the Color menu in the Windows driver
dialog or from the Color Options panel in the Mac 0S X Print dialog. In some applications you can make the choice
in the application itself. Consult the HP Support Center for guidance on how to use the color management
options of your particular application.

e  Application-Managed Colors: In this case your application program must convert the colors of your image to
the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC
profile of your printer and paper type.

e  Printer-Managed Colors: In this case your application program sends your image to the printer without any
color conversion, and the printer converts the colors to its own color space. The color management in the
printer is done using a set of stored color tables. ICC profiles are not used. This method can produce very
good results with supported HP paper types. There are two color spaces that the printer can convert to its
own color space using the stored color tables: sSRGB and Adobe RGB.

—  sRGB emulates the characteristics of the average computer monitor. This standard space is endorsed
by many hardware and software manufacturers, and has become the default color space for many
scanners, cameras, printers, and software applications.

—  Adobe RGB provides a larger color gamut than sRGB. Use this space if you need to do print production
work with a wide range of colors.

Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from printing
the same job on a different HP DesignJet printer, you can use the emulation mode provided by your printer.

[%f NOTE: Printer emulation is available only when printing an HP-GL/2 job on plain or coated paper. It is not
available from Mac OS X.

In the Windows HP-GL/2 driver dialog, click the Color tab, then Printer Managed Colors, then select Printer
Emulation from the Source Profile list. You can then select from the Emulated Printer list.
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Printing in grayscale or black-and-white
You can convert all colors in your image to shades of gray in the following ways:
e Inyour application program: Many applications provide this option.

e Inthe Windows driver dialog: Click the Color tab and look at the Color Options section. Click Print in
Grayscale. Only the black ink will be used for printing, except if the paper loaded is glossy, in which case
colored inks are used to compose the gray shades. You can also select Print in pure black and white if you
want only black and white output with no gray shades. In this case, only black ink will be used for printing.
The Print in pure black and white option is not supported when printing on glossy paper.

e  |nthe Mac OS X Print dialog: Click the Color Options panel and select Grayscale from the Mode drop-down
list. Only the black ink will be used for printing, except if the paper loaded is glossy, in which case colored
inks are used to compose the gray shades. You can also select Print in pure black and white if you want only
black and white output with no gray shades. In this case, only black ink will be used for printing. The Print in
pure black and white option is not supported when printing on glossy paper.
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7 Practical printing examples

° Print from Adobe Acrobat

° Print from Autodesk AutoCAD

—  Using printer emulation (T520 only)

—  Using clip contents by margins

e  Print from Adobe Photoshop

° Print and scale from Microsoft Office

- Using PowerPoint
— Using Project

- Using Excel
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Print from Adobe Acrobat

document size appears there.

In the Acrobat window, move the mouse cursor to the bottom left corner of the document pane until the

) T120 and T520 User's Guide.pdf - Adobe Acrobat Pro

File Ed\tiywew Document Comments Forms Tools Advanced Window Help

2D E & 45 =

o~ /00 73 o @&.mbme- FRE

OB E P

4} 1 (1ofl145) Th \"J "f;Q B ® 3% - ﬁ Find

@ DESIGNJET T120 and T520 Printer

series

User's Guide

2. Click File > Print and ensure that Page Scaling is set to None.

Print =

Printer

Name: |HP Designjet T120

-] [ Properties

Status:  Ready
Type:  HP Designjet T120

Comments and Forms:

[Document and Markups -

Print Range Preview: Composite
@Al

87—

©) Current view =

(©) Current page
CPages 1-142
Subset:  |All pages in range -

[ Reverse pages

R
Page Handing

[
Copies: 1 Collate 11,69
[¥] Auto-Rotate and Center

[ Cheose paper source by PDF page size

Use custom paper size when needed
e

Flermtio f Document: 8,3 x 11,7n

e Paper: 8,3x 11,7

[TJprint color as black 1150

[printing Tips | [ Advanced | [ Summarize Comments | [ oc ][ conea |

[%f NOTE: The page size will not be automatically selected according to the document size.
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3. Click the Properties button and then the Paper/Quality tab.

1 HP Designjet T120 Properties

Paper/Qualty | Features | Color | Senvicss [ Advanced

Quick sets:

Factory Defaults

v] [sae ] [ et

Paper Options

Document size: 210.00  257.00 mm
a4 -
[ margnstayout... || Custom...

% | currently loaded paper:

Printed on: 210,00 x 297.00 mm

Printer information not available

Paper source:
Printer auto select
Paper Type:
Any

Orientation
@ Portrait

(@) Landscape

@

Print Quality

@ Standard options

- U

Speed Quality
(@) Custom options Settings...
Rendering resolution (ppi): 300
Printing resolution (dpi): Automatic

4.  (Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom
paper size, click the Custom button.

IS

Custom Paper Size - :

LInits

@ Inches

(71 Millimeters
Paper size

Width:
Length:

Marme

Custom

8.27

11.69

Save

(3.00 - 24.25)

(5.51 - 3582.68)

o) (o]
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Click the Features tab, and then Autorotate.

-
= HP Designjet T120 Properties

Paper/Qualty | Features | Color | Services | Advanced

Quick sets:

[Factory Defauits

v [ sawe Delete

Resizing Options

@ Actual size

() Print document on:
A4

| () % of actual size:
100

i »

@

EN i
il

Printed on: 297.00 x 210.00 mm

Roll Options

[ Disable automatic cutter

[ Remaove top/bottom blank areas

[ Remove margins between pages
{8 [JRotate by 90 degrees

Autorotate

=

Click OK, and check that the print preview in the Print dialog box seems correct.

Type:  HP Designjet T120

Print Range

[]Reverse pages
Page Handing
Copies: 1 5 Collate

[¥] Auto-Rotate and Center

[] Choose paper source by PDF page size

Use custom paper size when needed

Print [ &= ]
Printer
Name: |HP Designjet T120 v] [ Properties
Status: Ready Comments and Forms:

[Document and Markups -

Preview: Composite

827 ——+

Ed

R p—

[,

e

Document: 8,3 x 11,7in

[Cprint to fie Paper: 8,3 x 11,7in
[ Print color as black 1/150
[Printing Tips | | Advanced | | Summarize Comments | [ o ][ concel

Print from Autodesk AutoCAD

The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

ENWW
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Enter new value for TILEMODE <1»: O Regenerating layout.

Cowmand: QVDRAWING

Command :

2.

Click the Plot icon at the top of the window.

Y= Sl

Plot... (Ctri+P)
Prints a drawing to a plotter, printer, or file

[ PLOT

[?] Press F1 for more help

3. The Plot window opens.

Bipo-Model

| Page setup
Hame: <Hone>
Frinter/plotter
Mame:  |@FP DesigelTi20
Platter: HP Designjet T120 - Optimized driver - by HP
Where:  c:loutput pdl
Description:
7 Pot to file
Faer sze
I
Plot area Plot scale
What to plot: [¥1Fit to paper
Scate: [Custom -
Flot offset (origin set to printable area) L [om )=
x: 1155 mm [ Center the plot 2.847
v 1365 mm Scale lneweights
rreven | [oyotopa | [oc | [Cconca ][ e | ®

4.  You can see further options by clicking the circular button in the lower right corner of the window.

Sre p—
@ Learn about Flotting
| Flat syle table (pen assignments)
Home: <Hone> =[] Hone B
Frinter/plotter Shaded viewport options
. EEEBaTD B
Flotter:  HP Designjet T120 - Optimized driver - by HP Quality ‘
Where:  crloutputpd = 150
Description:
Flot opions
7 Pot to file 1| Plot in background
I 7| Piot object linewoights
I ¥/|Plot with plot styles
/] Piot paperspace last
Flot area Plot scale Hids paperspace objects
What to plot: [¥Fit 1o paper | Flot stamp on
Dispiay. Scabe: | Custom - 1" Save changes to layout
Fiot offset (origin set to printable area) 1 mm 1 Drawing orientation
x WSS mm o [cemerthe plot e 0 @ toreat
i
o 15 [ Scale Ineweights [Pt upde-down
T = B

[%’ NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD

viewport objects that are sent for printing.

Chapter 7 Practical printing examples

ENWW



ENWW

Click the Properties button.

| &4 Plotter Configuration Editor - HP Designjet T120

[ General [ Ports._| Device ond Decument Setings |

& HP Dosignjet T120
&2 Media

D) Sounce and Size ¢Size AT>
& & Madia Destination <Default>

=& Userdefi et Sizes & Calibration
i Custom Paper Sizes.
i Modity Standard Paper Sizes (Printable Ases)
Fiter Peper Sizes

&

W Plotter Calibration
[ PMPFile Name <None>
i
Acoess Custom Dislag
Fress the following bution fo access the
| device drver-specific userinteriace.

I [ Custom Proparies..

i Import.. | | sevess. |

[ petours |

i [ ok | [ conca

] [ ]

Click the Device and Document Settings tab, then the Custom Properties button.

|98, Designjet T120 Properiies s

ﬁﬁi

|| | Papewauality |Featues [ Color [ Services | Advanced]

Quick sets:
[Factory Defautts

Paper Options
Document size: 594,00 % 841.00 mm

AL -

i Z | cumrenty loaded paper:
Printer information not available

Paper source:
Frinter ito select »
Paper Type:
Any -

i

Printed on: 594.00 x 841.00 mm

Print Quality

@ standard options.

@

Speed Quality
) Custom options Settings.
Rendering resolution (ppi): 300
Frinting resolution (dpi): Automatic
M
e |

[ox ][ cmen ]

In the Paper/Quality tab, select the paper type that you intend to use.

WESLHE Destoniet TL20 Propeitics i

ﬂi

|| | Papeqaualty | Featres | Color | Services | Advanced|

Quick sets:

[Factory.

Paper Options

Document size: 594,00 x 84100 mm

AL -

[ mergnsiapout... || Custorm...

i Z | currently loaded paper:
rinter information not avallable

Paper saurce:

Printer auto select -

Paper Type:

WP Bright White Inkjet Paper
| HP Universal Bond Paper
WP Coated Paper
| Plain paper

Heavyweight Costed paper

HP Universal Gloss Photo Paper
e Fhoto Gloss Paper

More...

Printed on: 594.00 x 841.00 mm

Print Qualty

@ Standard options

@

Speed Quality
*) Custom options SEMNGS...
Rendering resolution (ppi): 300
Printing resolution (dpi): Automatic
|
[ nen |

[ox ][ cmen ]

Select the print quality (your own choice between speed and quality of printing).

Print from Autodesk AutoCAD
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9. If youintend to print on roll paper, you must decide where the printer should cut the paper. Click the
Margins/Layout button, then Clip contents by margins.

Lay«nandMargimoglion- e a—

@) Print with margins
Loyout Options.
Standard
Oversize

@ Clip contents by margins

Usoge

Use this setting when the contents to be printed have white borders and a size
equal to that of the paper you have selected in the driver, The printer vill use
the white border for its margins and you will get 2 page of size equal to that
which is selected in the driver.

Print With Margins Preview

10. Click the Features tab, then the Autorotate option. Autorotation can help to avoid wasting paper.

% HP Designjet T120 Properties

PaperQuoity| Features |Color | Services | Advanced

Quick sets:

Resizing Optians

Q) Actual size.

Print document on:

\ % of actual size:

Roll Options

| Autoratate
Roll width:

.. .

i SRR

100 Frinted on: 54.00 % 841.00 mm

Disable automatic cutter
Remove top/battom blank areas
Remove margins between pages

Rotate by 90 degrees

e

11. Click the OK button and save your configuration changes to a PC3 file.

B: Changes to a Printer Configuration File “
| 1o 3 PC3 Printer C ]
| () Apply changes for the curent plot only

@) Save changes to the following fle: F

| [k [ coma [[ rew |
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12. If you have the HP DesignJet software suite installed, you will see a preview of the file you want to print.

b J el

Using printer emulation (T520 only)

Printer emulation can be requested by clicking Advanced settings > Color > Color management > Printer
Managed Colors > Printer emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins

You can select this option from Advanced settings > Paper/Quality > Margins/Layout > Print with margins >
Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you
have selected. The printer will use the white border for its margins and you will get a page of size equal to that
which is selected in the driver.

Print from Adobe Photoshop

ENWW

1. InPhotoshop CS5, click File > Print and then select your printer.

- — = =
Color Manzge...
Proter: P Designjet T120 9
@ Domment
(Profie: U.S. Web Coated (SWOF) v3)
Coples: 1 Proof
Pt setnge... | (G4
Color Handing:
7] Center Image Printer Manages Calors =
Toot | 10,5 §\ Remember to ensic the prver’s cior
2 management n e prindsetings daog box.
Lef: 5,08 printerProfie
Scaled Print sze @ RGB (1991
Rancerng Intent:
Sede toFittieda
Relatve Colormetrc -
Sce: 100%
e 45 ]. g |

width: 63,5
Priot Resolusion: 150 P61

| Bounding Box

Uit om -

o) e ]

e — e — —
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Choose from the available paper sizes.

[ wargmsnaro.. |[ cosom.. |

2 | Currently loaded paper:

Frinter information not available

2% HP Designiet T120 =
PaperCuaity [Faatres [ Color | Sanvices | Advanced] |
Quick sets:
Faper Optons
Document size: 594.00 x 841.00 mm

Print Qualy
l
Paper source: @ standard options
Frinter auto select - @
Poper Type: -
Ay =
Cusam oprans
Orientation
B Poran Rendering resolution (ppi): 300 |
* Landscape Frinting resolution (dpi): Automatic
q’.”
e,
o[ com

If you do not find the paper size that you intend to use, click the Custom button. Enter the width, the length

and the name of your custom paper size. Click the Save and OK buttons.

r - -
Custom Paper 542:': ‘ _ .@u
Units
@ Inches
(1 Millimeters
Paper size
Width: 8.27 (3.00 - 24.25)
Length: 11.69 (5.51 - 3582.68)
Mame
Custom
Save ! ! OK | Cancel
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3. You may wish to change the default paper source, paper type and print quality.

0 HP Designjet T120 -

Document size: 504,00 x 841,00 mm

Al -

2 | currently loaded paer:
Printer information not available:

Paper saurce:
Printer auto select -
Paper Type:

Origntation

@ Fortrait

” Landscape

Frinted an: 594.00 x 841.00 mm

Print Quality

@) Standard options

%)

Speed quality
7 custom options
Rendering resolution (ppi): 300
Printing resolution (dpi): Automatic
g S
[k ][ camcal

4. Inthe Color tab, the default color management option is Printer managed colors, and this is the correct
option because you have already selected Printer Manages Colors in Photoshop.

[Papes/Quaiy | Feanres| Color [Senices [ Advanced|
Quick sets:

%% HP Designjet T120 i

| Factory Defaults

Color Options
@ Frint in color

1 Print in grayscale
Frint in pure black and white

Color Management:
Agplication managed colors

@) Printer managed colors
Source profile:

o

Frinted on: 594.00 x 841.00 mm

L

Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office 2010.

Using PowerPoint

1.  Click the File tab, then Print, and select the name of your printer.

ENWW

Print and scale from Microsoft Office
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Bl W0+ ; Presentation] - Microsoft PowerPoint —— ==
Home  Insert  Design  Transitions  Animations  SlideShow  Review  View  AddIns  Acrobat - @
[0 | p——
Save As @ £ 2
1 Copies: |1 )
5 open
i on Print
L Close
15 Printer 9
|/ HP Designjet T120 .
Recent WP Ready
Printer Properties
Settings
Print Al Slides .
Print entire presentation
Save & Send
Slides:
Help [~ Full Page Slides .
Print1 slide per page
Add-Ins oale
Collated
i tontlon: 123 173 133
Exit
‘Color -
Edit Header & Footer
41 lofl » 16 % (=)-0—— ® &

2. Click Printer Properties > Features > Print document on to scale the document to a particular size.

) HP Designjet T120 Properties

| Papen/Quality | Features | Color | Services | Advanced

Quick sets:

[Factory Defaits

*) [sae | [ oee

Resizing Options

(@) Actual size

Print document on:

Al -
(@ % of actual size:

100

il 2

Document Size: 594.00 x 841.00 mm
Printed on: 594.00 x 841,00 mm

Roll Options
[ Disable automatic cutter

[ remove top/bottom blank areas
[ remove margins between pages

[ Rotate by 90 degrees
[ Autorotate
Reoll width: From printer
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3. Click the Paper/Quality tab, then Paper Source and Paper Type.

-
@ HP Designjet T120 Properties

=)

Paper/Qualty | Featurss | Color | Services [ Advanced

Quick sets:

Factory Defaults

v [ s Delete

Paper Options
Document size: 554,00 x 841,00 mm

Al -

[ Margnsiayout... || Custom...

# | currently loaded paper:

Printer information not available

Paper source:

Printer auto select -
Paper Type:

Any -

€ HPBright White Inkjet Paper
HP Universal Bond Paper
HP Coated Paper
Plain paper
Heavyweight Coated paper
HP Universal Gloss Photo Paper
Photo Gloss Paper
More. .

Printed on: 534.00 x 841,00 mm

Print Quality

@ Standard options

U

Speed Quality
() Custom options Settings...
Rendering resolution (ppi): 300
Printing resolution (dpi): Automatic

4.  Click Margins/Layout, then Clip contents by margins to keep the size.

LawutanuMugmseEtiqn - i an

Print With Margins
@) Print with margins.
Layout Options
Standard
Oversize

@ Clip contents by margins

Usage

Use this setting when the contents to be printed have white borders and a sze
equal to that of the paper you have selected in the driver. The printer will use
the white border for its margins and you will get a page of size equal to that
‘which is selected in the driver.

Using Project

1.  Click File > Page Setup > Print.

[ page Setup - Gantt Chart | e |
Page | Margins | Header | Footer Legend | View
Orientation
 Portrait © Landscape
Scaling
@ Adjustto:  [100 |5 s normal size
O Fitto: pages wide by [T Bl
Other
Paper Size: [A% =]
First page number:  [Auto
Print Preview... | [ gptions... | [ pint.. | [ ok | [ cancel

ENWW
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2. Select your printer's name, then Close.

[brint B

Printer
Name: HP Designjet T120 [~]
Stats:  Ide

Type:  HP Designiet T120

Where:

Comment:

Print range Copies

@al umber of comes: (1 12
ot o [ 1 [
== 7] Manual page bresks
@Al
() Dates From: |Tue 28/02/12 =

To: [Tue 23/02/12

[ Print left column of pages only.

3. Click Page Setup, and choose the Paper Size you want.

r -
Page Setup - Gantt Chart (2 [

Page | Margins | Header | Footer Legend | View
Orientation

Opayai  Lanioce
Sealing

@ Adjust to: % normal size
@ftto: [1 [ pageswideby [T FEal

Other

Paper Size: | I - |
First page number:

PrintPreview... | | Optons... | | pint.. | [ ok | [ cancdl

4.  Click Options to go to the printer driver. The default options in the Paper/Quality tab are probably suitable:
Paper source: Printer auto select and Paper Type: Any.

1 HP Designjet T120 Properties E

Paper/Qualty | Features | Color | Senvicss [ Advanced

Quick sets:

Factory Defaults v] [sae ] [ et

Paper Options

Document size: 210.00 x 297.00 mm

Ad -

[ margnstayout... || Custom...

% | currently loaded paper:

Printer information not available

Printed on: 210,00 x 297.00 mm

Print Quality

Paper source: @) Standard options

Printer auto select - @
Paper Type: Speed Quality
Any -
©) Custom aptions Settings...
Orientation
@ Portrait Rendering resolution (ppi): 300
() Landscape Printing resolution {dpi): Automatic

]
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Using Excel
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1.

Click Features > Print document on to scale the document to a particular size. Alternatively, you can scale

t

he document in Project.

-

@ HP Designjet T120 Properties

=)

Paper/Qualty | Features | Color | Services | Advanced

Quick sets:

[Factory Defauits

Delete

Resizing Options

() Actual size

Super B/A3
Super C/A2
Super D/AL

Roll Options

@

il

K;@

Document Size: 210.00 x 297.00 mm

I

Printed on: 210.00 x 257.00 mm

[ Disable automatic cutter
[ Remaove top/bottom blank areas
[ Remove margins between pages

[7] Rotate by 90 degrees
[ Autorotate
Foll width: From printer

Click the Page Layout tab, then Size, and choose the paper size you want.

Bookl - Microsoft Excel o (o] B
Insert | Pagelayout | Formulas  Data  Review  View  Adddns  Acobat @ =@ =
N — "= =1 o B
» Ij = 52 Width: | Automatic Gridlines  Headings @ E‘ ELLK; ‘III % ¢
3 ”ng 4 . - =
Q EI] 41] Height: Automatic ~ View View &= a .
Themes Margins Orientation| Size | Print Breaks Background Print N Bring Send  Selection Align Group Rotate
- [Ofetreds - | - - Area- Titles | Bl Seales (100% I || [ Print [ Print | Forward~ Backward =  Pane -
Themes Letter - & Scale to Fit | Sheetoptions Arrange
c10 " # D 21,59 cm x 27,94 cm -
A B [« Tabloid G H 1 J K L M N o P =
q 27,94 cm x 43,18 cm =
2 c
LB 143,18 cm x 55,88 cm
N
4 b |
5 55,88 cm x 86,36 cm
s 5
[l Legal F
7 D 21,59 cm x 35,56 cm
LB
B A
2 mx29.7 am
10 | ]
i =
11 A3
Iz 29,7 emx42 cm A
EE a2
14 42 anx 59,4 am
15 B4 150)
16 25 cmx 353 cm
17
B4 (JIS)
i 18 257 emx 36,4 cm
19
Arch A
= 22,86 cm 230,48 cm
21
2 Arch B
= 30,48 em x 45,72 cm
24 Arch €
! 45,72 em x60,96 cm -
4 4 » v| Sheetl Sheet2 . Sheet3 % Ml ul ] (a0}
Ready | More Paper Sizes... i
[ - -

Print and scale from Microsoft Office
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2.

3.

Click the File tab, then Print, and select the name of your printer.

-
|E| - R R Bockl - Microsoft Excel
Home  Insert  Pagelayout  Formulas  Data  Review  View  AddIns  Acrobat

[ save
Print
Save As @
= Copies: 1 s
o
& open Print
£ Qose -
Info Printer
|/ HP Designjet TL20 .
Recent - Ready
Printer Properties
New
Settings
Print Em————
- ‘ Print Active Sheets -
S : Only print the active sheets
Pages: 2| o 2
e=n [ Coteted .
@Add-}ns' 1,23 173 123
|z] Optiens \j Portrait Orientation -
B et — A4
A emx297 em 7
| Normal Margins
o Left 1,78 cm Right: 1,78 cm
[ Ne Scaling .
| [00] print sheets at their actual size
Page Setup

Click Printer Properties to go to the printer driver. In the Paper/Quality tab, click Paper source, Paper Type,

and Print Quality.

1 HP Designjet T120 Properties

Paper/Qualty | Features | Color | Senvicss [ Advanced

Quick sets:

Factory Defaults -

save | Delete

Paper Options

Document size: 210.00  257.00 mm
a4 -
[ margnstayout... || Custom...

% | currently loaded paper:

Printer information not available

@

Print Quality
Paper source: @ Standard options
Printer auto select - U
Paper Type: Speed Quality
Any -
() Custom options Settings...
Orientation
@ Portrait Rendering resolution (ppi): 300
) Landscape Printing resolution {dpi): Automatic

Printed on: 210,00 x 297.00 mm
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4,

Click Features > Print document on to scale the document to a particular size. Alternatively, you can scale

the document in Excel.

-
2 HP Designjet T120 Properties

a

==

Paper/Qualty | Features | Color | Services | Advanced

Quick sets:

[Factory Defauits

v] [ save | [ pee

Resizing Options

() Actual size

(@) Print document on:

Super B/A3
Super C/A2

Super D/AL

@

il

=L

Document Size: 210.00 x 297.00 mm
Printed on: 210.00 x 257.00 mm

Roll Options
[ Disable automatic cutter

[ Remaove top/bottom blank areas
[ Remove margins between pages

[7] Rotate by 90 degrees
[ Autorotate
Foll width: From printer

Print and scale from Microsoft Office

63



8 Handling ink cartridges and printhead

e  About theink cartridges

e  Storage of anonymous usage information

e  (heckink cartridge status

° Replace an ink cartridge

e  About the printhead
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About the ink cartridges

Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper. To
purchase additional cartridges, see Accessories on page 79.

A CAUTION:  Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the
Glossary on page 128). Avoid touching pins, leads and circuitry.

Storage of anonymous usage information

Each ink cartridge contains a memory chip that assists in the operation of the printer. In addition, this memory
chip stores a limited set of anonymous information about the usage of the printer, which can include the
following: the date when the cartridge was first installed, the date when the cartridge was last used, the number
of pages printed using the cartridge, the page coverage, the frequency of printing, the printing modes used, any
printing errors that may have occurred, and the product model. This information helps HP to design future
products to meet our customers' printing needs.

The data collected by the memory chip does not include information that could be used to identify a customer or
user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling program
(HP Planet Partners: http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The sampled memory
chips are read and studied in order to improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the data. Any third party possessing
the cartridge may be able to access the anonymous information on the memory chip. If you prefer to not allow
access to this information, you can render the chip inoperable. However, after you render the memory chip
inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip's ability to
collect printer usage information. To do so, access the Embedded Web Server, and click Settings > Anonymous
Usage Information Storage. This does not prevent the cartridge from working normally in other respects.
However, if you change your mind later, you can restore the factory defaults to resume collecting printer usage
information.

Check ink cartridge status
To view the ink levels of your ink cartridges, tap .] on the front panel.

For more information, tap More.

You can also get this information from the HP Utility:

e Inthe HP DesignJet Utility for Windows, go to the Supplies tab to see each cartridge's status.
° In the HP Utility for Mac 0S X, click Supplies Status in the Information group.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 106.

Replace an ink cartridge

There are two occasions when you need to replace an ink cartridge:

e  Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can
use up the remaining ink in the first cartridge at a more convenient time).

e Theink cartridge is empty or faulty, and you must replace it to continue printing.

ENWW About the ink cartridges 65


http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/

A CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION:  Remove an ink cartridge only if you are ready to insert another one.

@ NOTE: When a cartridge runs out of ink, the current job is cancelled.

1. Make sure the printer is turned on.

2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

3. Opentheink cartridge cover on the left-hand side of the printer.

4.  Wait until the carriage stops moving.

5. Press theink cartridge to unlock it.

66 Chapter 8 Handling ink cartridges and printhead ENWW



7. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the same
colored letter as the cartridge you are installing.

8.  Close theink cartridge cover.

About the printhead

The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink onto the
paper.

A CAUTION: Observe precautions when handling the printhead, because it is an ESD-sensitive device (see the
Glossary on page 128). Avoid touching pins, leads, and circuitry.
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9 Maintaining the printer

e  Check printer status

e  Take care of the printer

e  C(lean the exterior of the printer

e  Print Quality Diagnostic Report

e  (leanthe printhead

° Align the printhead

° Replace the printhead

° Clean the encoder strip

° Recalibrate the paper advance

° Move or store the printer

° Firmware update

e  Software update

° Printer maintenance kits
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Check printer status

You can check the current status of the printer in various ways:

e |fyou start the HP Utility and select your printer, you see a page of information describing the status of the
printer and its paper and ink supplies.

e |fyouaccess the Embedded Web Server, you see information about the general status of the printer. The
Supplies page in the Main tab describes the status of the paper and ink supplies.

° From the front panel, you can get information about the loaded paper and the ink levels.

Take care of the printer

The printer is not designed for any purpose other than printing, and you are not recommended to use it as a
table, for two reasons:

e  The surface can easily be damaged.

e  Anything that falls into the printer can cause more serious damage.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

AWARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean
it. Do not let water get inside the printer.

/\ CAUTION: Do not use abrasive cleaners on the printer.

Print Quality Diagnostic Report

The Print Quality Diagnostic Report consists of two test patterns designed to highlight printhead reliability
problems. It helps you to check the performance of the printhead that is currently installed in your printer, and
whether it suffers from clogging or alignment problems.

To print the Print Quality Diagnostic Report:

1. Use the same paper type that you were using when you detected a problem. The test patterns are easiest
to evaluate on plain white paper.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View
information about the paper on page 37.

At the printer's front panel, tap , then Image Quality Maintenance > Print diagnostic image.

l%" NOTE: The report can also be requested from the Embedded Web Server.

It takes about two minutes to print the Print Quality Diagnostic Report.
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Test Pattern 1

If the lines are not straight and connected, align the printheads.

Test Pattern 2

If you see thin white lines across any of the colored blocks, clean the printheads.

1. Ifthelinesin Test Pattern 1 are not straight and connected, align the printhead (see Align the printhead
onpage 71).

Corrective actions

2. Ifany of the colored blocks in Test Pattern 2 show white lines, or are faded or completely missing, clean the
printhead (see Clean the printhead on page 70). Follow the front-panel prompts and perform all three
levels of cleaning if necessary.

3.  If the problem remains, clean the printhead again.

4.  If the problem remains, replace the ink cartridge (see Replace an ink cartridge on page 65) corresponding to
the streaked, faded, or missing color block in Test Pattern 2.

5. If the problem remains, replace the printhead (see Replace the printhead on page 71). If the printhead is
still in warranty, contact HP Support (see Contact HP Support on page 122).

Clean the printhead
If your print is streaked or has incorrect or missing colors, the printhead may need to be cleaned.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and uses an
increasing amount of ink. After each stage, review the quality of the printed page. You should initiate the next
phase of cleaning only if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printhead.

[%9 NOTE: Cleaning uses ink, so clean the printhead only when necessary.

[*_'%f“ NOTE: Failing to turn off the printer correctly can cause print-quality problems.

Clean the printhead from the front panel

1. Make sure there is paper in the input tray or a roll loaded.
2. . . .
Go to the front panel and tap j , then Image Quality Maintenance > Clean printhead.
Clean the printhead from the Embedded Web Server

1. Make sure there is paper in the input tray or a roll loaded.

2. Inthe Tools tab of the Embedded Web Server, click Print Quality Toolbox > Clean Printhead, and follow the
instructions on the screen.
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Clean the printhead from the HP Utility
1. Make sure there is paper in the input tray or a roll loaded.

2. Windows: In the Support tab of the HP Utility, click Printhead Cleaning, and follow the instructions on the
screen.

3. Mac0S X: In the Information and Print Quality tab of the HP Utility, click Clean Printhead, and follow the
instructions on the screen.

Align the printhead

Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in
graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead
has been accessed or replaced.

You may need to align the printhead after a paper jam or if you are experiencing print-quality problems.

1. Load the paper you wish to use, see Paper handling on page 29. You can use a roll or a cut sheet; plain
white paper is recommended.

A CAUTION: Do not use transparent or semi-transparent paper to align the printhead.

2. Ensure that the window is closed, as a strong light source near the printer during printhead realignment can
affect alignment.

3. From the front panel, tap , then Image Quality Maintenance > Align printhead.

[%”f NOTE: Printhead alignment can also be started from the Embedded Web Server (Tools > Print Quality
Toolbox > Align Printhead), or from the HP Utility (Windows: Support > Printhead Alignment; Mac OS X:
Information and Print Quality > Align).

4.  If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

5. The process takes about five minutes. Wait until the front-panel display shows the process complete before
using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead and
try again.

Replace the printhead

9 TIP:  When the printhead has been replaced, the printer will automatically perform a printhead alignment on
the loaded paper. If you would like to perform the printhead alignment on a different paper (perhaps from the
multi-sheet tray), you could change the paper before starting this procedure. Plain white paper is recommended.

1. Make sure the printer is turned on.

2. Ifyour printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

From the front panel, tap , then Image quality maintenance > Replace printhead.
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4.  Open theink cartridge cover.

5. Wait until the carriage stops moving.

6.  Press each ink cartridge to unlock it.

7.  Remove each ink cartridge.
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8.

9.

Close the ink cartridge cover.

Tap Next on the front panel.

10. Open the top cover.

11.

Raise the carriage lever.

Replace the printhead
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12. Remove the printhead, keeping it vertical to avoid getting ink on the connections.

13.

14.

15. Close the top cover.
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16. Tap Next on the front panel.

17. Opentheink cartridge cover.

18. Insert the ink cartridges. Make sure that you insert each ink cartridge into the slot that has the same
colored letter as the cartridge you are installing.

@ IMPORTANT: If the printhead is new, install new ink cartridges. New ink cartridges are required for
successful printhead replacement.

19. Close theink cartridge cover.

20. Tap Done on the front panel. The front panel recommends a printhead alignment.
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Clean the encoder strip

1. Make sure that the printer is not printing and that the carriage is located in the service station on the right-
hand side of the printer.

2. Using tap water and a small cloth that will not leave fibers in the printer, dampen the cloth and remove any
excess water, so that the cloth is damp but not wet.

3. Open the printer window.

4.  Hold the cloth in aninverted U shape around the encoder strip and carefully wipe until no further ink
residue appears on the cloth. Be very careful not to scratch the encoder strip with your fingernails or any
other object. Make sure that you are holding the cloth correctly.

[:?’”f’ NOTE: Do not move the carriage away from the service station.

5. Close the printer window.

From the front panel, tap , then Image guality maintenance > Replace printhead. The carriage moves

to the left and stops in the correct position to remove the printhead.
7. Turn off the printer by pressing the power key and then unplugging the power code.

8.  Open the printer window and move the carriage further to the left, allowing you to access the service
station.

9.  (lean the part of the encoder strip inside the service station as described above.
10. Close the printer window.
11. Turnthe printer back on.

If you would like further guidance on this procedure, see the Service Manual.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement of
dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark
bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select
the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if
you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the
paper advances. See Troubleshooting print-quality issues on page 94 to determine whether paper advance
calibration will solve your issue.

Recalibrating the paper advance procedure

1. From the front panel, tap , then Image Quality Maintenance > Paper advance calibration > Calibrate

ready paper. The printer automatically recalibrates the paper advance and prints a paper advance
calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

A,

B NOTE:  The recalibration procedure takes approximately three minutes. Do not worry about the paper
advance calibration image. The front-panel display shows any errors in the process.
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If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to
the default calibration, see Return to default calibration on page 77.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To
return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, tap , then Image Quality Maintenance > Paper advance calibration > Reset ready
paper calibration.

2. Wait until the front panel displays the operation has completed successfully.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the printer,
follow the instructions below.

1. Do not remove the ink cartridges or printhead.

2. Make sure that no paper is loaded.

3. Turn off the power using the Power key on the front panel.
4. Unplug the printer's power cord.

5. Disconnect any cables connecting the printer to a network or a computer.

A CAUTION:  If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the
printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off for a
six weeks or more, preparing the printhead could take up to 45 minutes.

A CAUTION: If the printer remains off for a long period of time, the printhead may become unusable. In this case,
you need to replace the printhead with a new one.

X TIP: Because preparing and purging the printhead uses both time and ink, you are strongly recommended to
leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printhead. In both
cases, the printer wakes up from time to time to maintain the printhead. Thus you can avoid going through
lengthy preparation processes before using your printer.

Firmware update

There are various ways of downloading and installing firmware updates, as described below; you can choose
whichever you find most convenient.

Ej?’y NOTE: A firmware update package can be large; you may want to consider whether there are any implications
for your network or Internet connection.

You can configure the printer to download firmware updates automatically whenever they become available: see
Automatic firmware update on page 20.
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The following options are available if you choose manual firmware updates:

Using the front panel, tap , then Web Services > Product update. Tap Check now to check whether new

firmware is available. If new firmware is available, you are given the opportunity to download and install it.
e  Using the Embedded Web Server, click Firmware Update.
e  Using the HP DesignJet Utility under Windows, select your printer, the Support tab, then Firmware Update.
e  Using the HP Utility under Mac OS X, click Update Firmware in the Support group.

The firmware includes a set of the most commonly used paper presets.

Software update

Under Windows or Mac OS X, you are normally offered software updates automatically.

For manual updates of printer drivers and other software for your printer, go to http://www.hp.com/go/T120/
software or http://www.hp.com/qgo/T520/software.

Printer maintenance kits

Three maintenance kits are available for your printer, containing components that may need to be replaced after
long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 122) and request
the maintenance kit. The kits are installed by service engineers only.
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

e \Visit http://www.hp.com/go/T120/accessories or http://www.hp.com/qgo/T520/accessories on the Web.

e  Contact HP Support (see Contact HP Support on page 122).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 10-1 Ink cartridges

Cartridge Part number
HP 711 38 ml Black Ink Cartridge CZ129A
HP 711 29 ml Cyan Ink Cartridge CZ130A
HP 711 29 ml Magenta Ink Cartridge CZ131A
HP 711 29 ml Yellow Ink Cartridge CZ132A
HP 711 80 ml Black Ink Cartridge CZ133A

Table 10-2 Printhead

Printhead Part number
HP 711 DesignJet Printhead Replacement Kit C1Q10A
Order paper

The following paper types are currently provided for use with your printer.

99

B’ NOTE:  This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/LFPrintingMaterials.

99

[ NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability
e  (A)indicates papers available in Asia (excluding Japan)
e (O indicates papers available in China
e (F)indicates papers available in Europe, the Middle East and Africa
e  (J))indicates papers available in Japan
e (L)indicates papers available in Latin America
e (N)indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.
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Table 10-3 Roll paper

Paper type g/m? Length Width Part numbers

HP Bond and Coated Paper

HP Recycled Bond Paper 80 45.7m (150 ft) 420 mm (16.54 in) (A2) CG892A (E)
610 mm (24 in) CG889A (EN)
914 mm (36in) CG890A (EN)

HP Universal Bond Paper 80 45.7 m (150 ft) 594 mm (23.39in) (A1) Q8003A (A))
610 mm (24 in) Q1396A
914 mm (36in) Q1397A

HP Bright White Inkjet Paper 90 45.7 m (150 ft) 420 mm (16.54 in) (A2) Q1446A (EJ)
594 mm (23.391n) (A1) Q1445A (E))
610 mm (24 in) C1860A (LN),

C6035A (AEJ)
841 mm (33.11in) (AQ) Q1444A (E))
914 mm (36 in) C1861A (LN),
C6036A (AEJ)

HP Universal Coated Paper 95 45.7 m (150 ft) 610 mm (24 in) Q1404A (AEJN)
974 mm (36in) Q1405A (AEJN)

HP Coated Paper 90 45.7 m (150 ft) 420 mm (16.54 in) (A2) Q1443A (J)
457 mm (18in) Q7897A (EJN)
594 mm (23.391in) (A1) Q1442A (E))
610 mm (24 in) C6019B
841 mm (33.11in) (AO) Q1441A (E))
914 mm (36in) (€6020B

HP Universal Heavyweight Coated 120 30.5m (100 ft) 610 mm (24 in) Q14712A (AEJN)

Paper
914 mm (36in) Q1413A

HP Heavyweight Coated Paper 131 30.5m (100 ft) 610 mm (24 in) (6029C (AEIN)
974 mm (36in) C6030C

HP Yellow Colored Paper 92 45.7 m (150 ft) 914 mm (36 in) Q1760A (EN)

HP Technical Paper

HP Natural Tracing Paper 90 45.7 m (150 ft) 594 mm (23.39in) (A1) Q1439A(J)
610 mm (24 in) (3869A
914 mm (36 in) (3868A

HP Translucent Bond Paper 67 45.7 m (150 ft) 610 mm (24 in) C3860A (AJN)
914 mm (36in) (3859A (LN)

HP Vellum Paper 75 45.7 m (150 ft) 610 mm (24 in) (3862A (N)
914 mm (36in) C3861A (LN)

HP Film (Technical and Graphic)

HP Clear Film 174 22.9m (75 ft) 610 mm (24 in) (3876A (AEJN)

How to order supplies and accessories
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Table 10-3 Roll paper (continued)

Paper type g/m2 Length Width Part numbers
974 mm (36 in) C3875A
HP Matte Film 160 38.1m (125 ft) 610 mm (24 in) 51642A (AEJN)
974 mm (36 in) 51642B
HP Photographic Paper
HP Premium Gloss Photo Paper 240 15.2m (50 ft) 610 mm (24 in) (7984A
22.9m (75 ft) 914 mm (36 in) Q8806A
HP Premium Satin Photo Paper 240 15.2m (50 ft) 610 mm (24 in) CZ987A
22.9m (75 ft) 914 mm (36 in) Q8808A
HP Universal Gloss Photo Paper 190 30.5m (100 ft) 610 mm (24 in) Q1426A (AEIN)
974 mm (36 in) Q1427A (AEJN)
HP Universal Satin Photo Paper 190 30.5m (100 ft) 610 mm (24 in) Q1420A (AEIN)
974 mm (36 in) Q14271A (AEJN)
HP Universal Instant-dry Gloss Photo 200 30.5m (100 ft) 610 mm (24 in) Q6574A
Paper
974 mm (36 in) Q6575A
HP Universal Instant-dry Satin Photo 200 30.5m (100 ft) 610 mm (24 in) Q6579A
Paper
974 mm (36 in) Q6580A

TIP:  The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more than
two weeks, you should laminate them to achieve longer life.

HP Self-Adhesive Material
HP Everyday Adhesive Matte 180 22.9m (75 ft) 610 mm (24 in) (G843A
Polypropylene
974 mm (36 in) (G824A
HP Banner and Sign Material
HP Everyday Matte Polypropylene 120 30.5m (100 ft) 610 mm (24 in) CHO022A
974 mm (36in) CHOZ23A
Table 10-4 Sheet paper
Paper type g/mz Length Width Part numbers
HP Bond and Coated Paper
HP Coated Paper 90 610 mm (24 in) 457 mm (18in) Q1961A (AEIN)
974 mm (36 in) 610 mm (24 in) Q1962A (AEN)
HP Photographic Paper
HP Premium Gloss Photo Paper 240 483 mm (19in) 330mm(13in) CZ985A
610 mm (24 in) 457 mm (18 in) CZ986A
HP Premium Satin Photo Paper 240 483 mm (19in) 330mm (13 in) (Z988A
610 mm (24 in) 457 mm (18 in) CZ989A
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Order accessories

The following accessories can be ordered for your printer.

Name Product number
HP DesignJet T120 24-in Stand B3Q35A
HP DesignlJet T120 and T520 24-in Spindle B3Q36A
HP DesignJet T520 36-in Spindle B3Q37A

Introduction to the accessories
Stand

The stand is provided with the T520, except for the T520-24T. It is not provided with the T120 or T520-24T, but
may be purchased as an accessory.

Spindle

With extra spindles, you can change rapidly from one paper type to another.
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Troubleshooting paper issues

Paper cannot be loaded successfully

Paper type is not in the driver

Printer printed on the wrong paper type

Paper mismatch
Roll has jammed

Multi-sheet tray has jammed

A strip stays on the output tray and generates jams

Printer displays out of paper when paper is available

Prints do not fall neatly into the bin

Sheet stays in the printer when the print has been completed

Paper is cut when the print has been completed

Cutter does not cut well

Rollis loose on the spindle
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Paper cannot be loaded successfully

Ensure that no paper is already loaded.
Ensure that the paper is far enough inside the printer, you should feel the printer grab the paper.

Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-
panel display. The printer automatically attempts to straighten the paper.

The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load

Check that the roll is at least 280 mm (11 in) wide: narrower rolls are not supported.

Check the leading edge of the paper: if it is not straight or clean, it should be trimmed. Remove the initial 20
mm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.

Check that the roll ends are tight against the spindle ends.

Check that the spindle is correctly inserted.

Check that the output tray is closed. The roll will not load when it is open.

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
Check that all roll end plugs have been removed.

Check that the paper is wound tightly on the roll.

Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, follow the instructions on the front panel.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from
the end of the spindle until the edge is removed from the printer.

[:?’”r NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

Check that the sheet is more than 329 mm (12.95 in) wide (A3+). If it is that width or less, load it from the
multi-sheet tray.

Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
Ensure that the sheet is aligned with the reference line on the roll cover.

Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel
display.

Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the
sheet from the front of the printer.
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Unsuccessful load from the multi-sheet tray

e  (heck that you have not loaded too many sheets into the tray. The maximum number of sheets depends
on the paper thickness: around 50 sheets of plain, standard paper.

e  (Check that the sheets are correctly loaded into the tray.

e  (heck that the sheets are correctly adjusted and centered in the tray.

e  (Check that you have extended the input and output trays correctly: the first extension for A4, the second
for A3 paper.

=ty

[%9 NOTE: Try to avoid leaving sheets of paper loaded in the printer for a significant length of time, because they
will deform.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Front-panel message Suggested action

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much skew. Tap
OK to unload the roll automatically, then restart the process.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper is
inserted fully and is not transparent.

Paper too far from lateral edge Reload the cut sheet, aligning the right edge against the black stop on the spindle.
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Front-panel message Suggested action

Paper load failed. Paper width is smaller than  Cut sheets smaller than ISO A3 must be loaded using the multi-sheet tray.
the minimum size supported by the selected

paper source.

Sheet too big During the load process the printer has detected that the sheet of paper is either too wide
or too long to be loaded correctly. Tap . to stop the load process. See Functional
specifications on page 124.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow or too

short to be loaded in the printer. Tap . to stop the load process. See Functional
specifications on page 124.

Paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver,
however, you must identify whether your paper is transparent or translucent, photo or bond, coated or technical.

[%”Nf NOTE: For glossy paper, it is important to select a glossy paper type, as the printer adjusts its use of ink for
glossy paper.

Transparent or translucent film
If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear film.

If your paper is a translucent paper or film (for example, technical paper), select paper type Film > Matte film.

Photo paper

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper type
Photo Gloss Paper. For Semi-gloss, Satin, Pearl, or Luster finishes, select paper type Photo Semi-gloss/Satin
Paper.

To increase gamut on photo paper, select paper type HP Universal Gloss Photo Paper or HP Universal Satin Photo
Paper, depending on the finish.

Bond and coated or technical paper
Your paper type selection for generic paper depends on the paper’s ink absorption capacity:

e  For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing Paper >
65 g/m2, depending on the weight of the paper.

e  For thin papers (< 90 g/m?) or uncoated papers (for example plain paper or bright white paper), select
paper type Bond and Coated Paper > Plain Paper. You can also select Recycled Bond Paper.

e  For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated Paper.

e  For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper > Heavyweight
Coated Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use an optimized ink combination, select
paper type Photo Paper > Photo Gloss Paper.
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After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from
thinnest to thickest are:

e  Plain Paper
e  (oated Paper
e  Heavyweight Coated Paper

For other print-quality problems, see Troubleshooting print-quality issues on page 94.

Printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Any selected for the
Paper Type in the printer driver. When Any is selected the printer will print immediately on whichever paper is
loaded. Load your desired paper, see Paper handling on page 29, and select your paper type specifically in the
driver.

e  Inthe Windows driver dialog: Click the Paper/Quality tab, then select your paper type from the Paper Type
list.

e  Inthe Mac 0S X Print dialog: Click the Paper/Quality panel, then select your paper type from the Paper Type
list.

[%]’9 NOTE: Anyis the driver default.

Paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job, the printer stops and waits for you
to decide what to do. There are several ways in which the loaded paper may be considered unsuitable:

e  The paper type is not as specified for the job.

e  The paper source (roll, multi-sheet tray, or manual feed) is not as specified for the job.

e  The paper size is smaller than specified for the job.

If you do not specify these things for a particular job, the printer will print on whatever paper is loaded.

If the printer stops for a paper mismatch, you can decide among the following alternatives:

e  Loadthe correct paper and resume printing.

e  Print the job on the already-loaded paper. The print may be clipped if the paper is not large enough.

° Cancel the job.

Roll has jammed

When a paper jam occurs, you normally see a message about it in the front-panel display.

1. Open the top cover.
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2. Try to move the printhead carriage out of the way.

A CAUTION: Do not move the paper sideways, as it could damage the printer.
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4.  Close the top cover.

5. Open the roll cover and rewind the roll. You may feel resistance if the paper is stuck; pull firmly.

6.  Reload theroll, or load a new sheet; see Paper handling on page 29.

@ NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure
and carefully remove all pieces of paper. You may need to remove the multi-sheet tray (see Multi-sheet tray has
jammed on page 90).

Multi-sheet tray has jammed

If the paper in the multi-sheet tray has jammed, proceed as follows:
1. Remove as much paper as you can from the multi-sheet tray.
2. Push down the multi-sheet tray extensions, which will make the tray easier to handle.

3. Unlock the tray, using the rotary switch behind it.
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4. Pull out the tray.

ENWW Multi-sheet tray has jammed 91



8. Lock the tray.

A strip stays on the output tray and generates jams

If a small piece of paper has been cut, such as before printing a new roll, or after the front panel option Form
feed and cut has been used, the cut strip may remain in the output tray. Only when the printer is not printing,
reach into the tray and remove the strip.

Printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the bin

e  Ensure the binis correctly installed.
e  Ensurethe binis open.
e  Ensure the binis not full.

e  Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or
remove prints manually as they are completed.

Sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 37. If the
paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter
is disabled, use the Form feed and cut option in the front panel, see Form feed with or without cutting

on page 38.
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Paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time
on page 37. You can disable the cutter, see Turn the automatic cutter on and off on page 37.

Cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles,
and check that there are no pieces of paper in the cutter groove.

Roll is loose on the spindle

The roll may need to be replaced or reloaded.
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12 Troubleshooting print-quality issues

° General printing advice

° Horizontal lines across the image (banding)

° Lines are too thick, too thin or missing

° Lines appear stepped or jagged

° Lines print double or in the wrong colors

° Lines are discontinuous

° Lines are blurred

° Line lengths are inaccurate

° Whole image is blurry or grainy

° Paper is not flat

° Print is scuffed or scratched

° Ink marks on the paper

° Black ink comes off when you touch the print

° Edges of objects are stepped or not sharp

° Edges of objects are darker than expected

e  \Vertical lines of different colors

° White spots on the print

° Colors are inaccurate

e  (olors are fading

e |mageisincomplete (clipped at the bottom)

° Image is clipped

e  Some objects are missing from the printed image

° A PDF file is clipped or objects are missing

° If you still have a problem
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General printing advice
When you have any print-quality problem:

e  Toachieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper on page 80.

e  Make sure that the paper type selected in the front panel is the same as the paper type loaded into the
printer (see View information about the paper on page 37). Also make sure that the paper type selected in
your software is the same as the paper type loaded into the printer.

A CAUTION:  If you have the wrong paper type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printhead.

e  (heck that you are using the most appropriate print-quality settings for your purposes (see Printing
on page 39). You are likely to see lower print quality if you have moved the print-quality slider to the 'Speed'
end of the scale, or set the custom quality level to Fast.

e  (heck that your environmental conditions (temperature, humidity) are in the recommended range. See
Environmental specifications on page 127.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 37.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 39). In
some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For
instance, if you have set the Print Quality slider to Speed, try setting it to Quality.

3. Print the Print Quality Diagnostic Report. See Print Quality Diagnostic Report on page 69.

4.  If the printhead is working correctly, perform paper advance calibration: see Recalibrate the paper advance
on page 76.

If the problem persists despite all the above actions, contact your customer service representative for further
support.
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Lines are too thick, too thin or missing

5.

u
Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 37.

Check that you are using appropriate print-quality settings for your purposes (see Printing on page 39).
Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if
available).

If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality.
You can find the Max. Application Resolution option in the driver dialog's Advanced tab, under Document
Options > Printer Features.

If lines are too thin or missing, print the Print Quality Diagnostic Report. See Print Quality Diagnostic Report
on page 69.

If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 76.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

The problem may be inherent in the image. Try to improve the image with the application you are using to
edit it.

Check that you are using appropriate print-quality settings. See Printing on page 39.

Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if
available).
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Lines print double or in the wrong colors

This problem can have various visible symptoms:

e  (olored lines are printed double, in different colors.

Q

N\

e  The borders of colored blocks are wrongly colored.

To correct this kind of problem, print the Print Quality Diagnostic Report, and align the printhead if recommended
in the report. See Print Quality Diagnostic Report on page 69.

Lines are discontinuous

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 39.

2. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print
Quality Diagnostic Report on page 69.
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Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1.

Check that your environmental conditions (temperature, humidity) are suitable for high-guality printing.
See Environmental specifications on page 127.

Check that the paper type selected in the front panel is the same as the paper type you are using. See View
information about the paper on page 37.

Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.
Select a lower print quality (such as Speed); the printer will then use less ink.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper.

If you are using glossy paper, try changing to a different type of glossy paper.

Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print
Quality Diagnostic Report on page 69.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes,
you can try to improve line length accuracy in the following ways:

1.

W

Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 124.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner
or thicker than HP Matte Film will reduce line length accuracy.

Set the Print Quality slider to Quality.
Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes befare printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance
on page 76.
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Whole image is blurry or grainy

5.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 37.

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see Printing on page 39). In some cases, you
can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you
have set the Print Quality slider to Speed, try setting it to Quality.

Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See Print
Quality Diagnostic Report on page 69.

If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 76.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes
saturated with ink.

ENWW
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Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 37.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.
Select a lower print guality (such as Speed); the printer will then use less ink.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper.

Whole image is blurry or grainy
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Print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after printing,
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:
° Handle prints carefully.
e  Avoid stacking prints on top of each other.

e  (atchyour prints as they are cut from the roll and do not let them fall into the bin. Alternatively, leave a
sheet of paper in the bin so that freshly printed sheets do not make direct contact with the bin.

Increase the drying time. At the front panel, tap , then Printer Preferences > Print Retrieval > Select
drying time > Extended.

Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printhead
moves over the paper, the printhead may come into contact with the paper and smear the printed image. This
problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you natice this problem, cancel the printing job immediately. Tap | and also cancel the job from your
computer application. Soaked paper can damage the printhead.

If you notice poor print quality after this has happened, clean the printhead. See Clean the printhead on page 70.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 37.

2. Usearecommended paper type (see Order paper on page 80) and the correct print settings.

3. Ifusing sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect
performance.

4.  Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.
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5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper.

6.  Trytoincrease the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

Clean the platen with a soft cloth. Clean each rib separately.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select Photo
Glossy Paper as the paper type (in the Photo Paper category).

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the print-
quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the guality
level to Speed. See Printing on page 39.

Edges of objects are darker than expected

If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality in the

driver dialog, select the custom print-quality options, and try setting the quality level to Speed. See Printing
on page 39.
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Vertical lines of different colors

If your print has vertical bands of different colors along it:

1. Tryusing thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated
Paper. See Order paper on page 80.

2. Tryusing higher print-quality settings (see Printing on page 39). For instance, if you have set the Print
Quality slider to Speed, try setting it to Quality.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material. To
avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:
1. Check that the paper type you have loaded corresponds to the paper type selected.
2. (Checkthat you are printing on the correct side of the paper.

3. (Check that you are using appropriate print-quality settings. For the most accurate colors, select Normal or
Best quality.

4.  Print the Print Quality Diagnostic Report. See Print Quality Diagnostic Report on page 69.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than
two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints
(depending on the type of lamination) with all paper types. For more information, consult your laminate provider.
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Image is incomplete (clipped at the bottom)

e  Didyou tap ll before all the data were received by the printer? If so, you have ended the data transmission
and will have to print the page again.

e  Thel/O timeout setting may be too short. This setting determines how long the printer waits for the
computer to send more data, before deciding that the job is finished. From the front panel, increase the |I/0

timeout setting to a longer period and then send the print again. Tap , then Connectivity > Advanced

setup > Select I/0 timeout.

e  There may be a communications problem between your computer and the printer. Check your USB or
network cable, or your Wi-Fi connection.

e  (Check to make sure that your software settings are correct for your current page size (for example, long-
axis prints).

e Ifyou are using network software, make sure it has not timed out.

Image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the
printable area as understood by your software.

e  (heck the actual printable area for the paper size you have loaded.
printable area = paper size —margins

e  (heck what your software understands to be the printable area (which it may call "printing area" or
"imageable area"). For example, some software applications assume standard printable areas that are
larger than those used in this printer.

e |fyou have defined a custom page size with very narrow margins, the printer may impose its own minimal
margins, clipping your image slightly. You may want to consider using a larger paper size.

e |fyourimage contains its own margins, you may be able to print it successfully by using the Clip Contents
by Margins option (see Select margins options on page 43).

e |[fyouaretrying to print a very long image on a roll, check that your software is capable of printing an
image of that size.

e  You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

e |Ifnecessary, reduce the size of the image or document in your software application, so it fits between the
margins.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific
workflows there may be issues that can lead to some objects missing from the output. Here are some
suggestions to help you to avoid this problem:

Tell the HP-GL/2 driver to send the image as a bitmap.

e  Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

Save the file in another format, such as TIFF or EPS, and open it with another application.

Use a RIP to print the file.
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e  Reduce the resolution of bitmap images in your application software.

e  Select alower print quality in order to reduce the resolution of the printed image.

r.%’ NOTE: If you are working under Mac 0S X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or
the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to solve the
problem.

A PDF file is clipped or objects are missing

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects when
printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such problems, upgrade your
Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards, these problems should
be solved.

If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further
things that you can do:

e  Tryusing a higher print-quality option. See Printing on page 39.

e  (heck the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded
from http://www.hp.com/go/T120/software or http://www.hp.com/go/T520/software.

e  (Check that your printer's firmware is up to date. See Firmware update on page 77.

e  (heck that you have the right settings in your software application.
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13 Troubleshooting ink cartridge and printhead
issues

° Cannot insert an ink cartridge

° Ink cartridge status messages

° Cannot insert the printhead
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Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. (Checkthat the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side
up and readable.

A CAUTION:  Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:
e  OK: The cartridge is working normally, with no known problems.

e  Missing or Damaged: There is no cartridge present, or it is not correctly connected to the printer (shown
with an X on the status screen).

e  Low: Theinklevelis low.

e  Qutofink: The cartridge is empty.

e  Not genuine HP: The cartridge is not a genuine HP cartridge.

e  Wrong slot: The cartridge has been inserted into the wrong slot.

e  Incompatible: The cartridge is incompatible with this printer.

Cannot insert the printhead

1. Check that you have the correct type of printhead (model number).
2. Checkthat you have removed the orange protective cap from the printhead.
3. Check that the printhead is correctly oriented.

4.  Check that you have correctly latched the printhead, see Replace the printhead on page 71.
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Troubleshooting data communication issues

Communication failures between computer and printer

Wired network issues

—  Network port created does not match printer IP address (Windows)

Wireless network issues

—  Advanced wireless network troubleshooting

—  Add hardware addresses to a wireless access point (WAP)

Mobile Printing issues

Network configuration page
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Communication failures between computer and printer

Some symptoms are:

e  The front-panel display does not show the Printing message when you have sent an image to the printer.
e  Your computer displays an error message when you are trying to print.

e Your computer or printer hangs (stays idle), while communication is taking place.

e  Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

e  Ensure that you have selected the correct printer in your application, see Printing on page 39.

e  Ensure that the printer works correctly when printing from other applications.
e  Remember that very large prints may take some time to receive, process and print.

e [fthe printeris connected to a network, check the printer connectivity status: the printer should have an IP
address and it should match the IP address specified in the printing computer. If the addresses do not
match, then configure it correctly; if the issue persists, check your network configuration or try connecting
to the printer by USB cable.

e  Tryanotherinterface cable.

e  [fthe printeris connected by USB cable, try disconnecting and reconnecting the USB cable. Also try using a
different USB port on the computer.

e |[fthe printeris connected to a wireless network, you can request a diagnostic report from the front panel:
tap {fflll then Settings > Print Wireless Network Test. Alternatively, try moving the printer closer to the
wireless router, or try connecting the printer by wired network or USB cable.

When a network device automatically configures itself by receiving an IP address from the DHCP service, this IP
address may change from the last time the device is powered off to the next time it is powered on, which may
lead to the device being shown as "offline" when driver port settings are configured with the original IP address.
There are at least three possible ways to avoid this:

e Increase the lease time of your DHCP server device.
e  Setafixed IP address for your printer that will not be changed by DHCP.
e  Configure the printer and driver to refer to the hostname instead of the numeric IP address.

To set a fixed IP address for the printer:
1. Goto the front panel and tap |4 & o I

2. At the bottom of the screen, tap Settings > Advanced setup > IP settings > OK > Manual, and enter the [P
address, the subnet mask, and the gateway (those settings should be provided by your network
administrator).

To use the hostname instead of the numeric IP address:
1. Goto the front panel and tap {4 J or =8

2. Take anote of the IP address and the hostname (HPXXXXXX format).

3. If your computer is running Windows, go to Control Panel > Printers, right-click the printer and click
Properties > Ports > Configure Port, and in the Printer name or IP address field enter the hostname.
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Wired network issues

If you are unable to install the HP software provided with the printer, check that:
e  All cable connections to the computer and the printer are secure.
e  The networkis operational and the network hub is turned on.

e  Allapplications, including virus protection programs, spyware protection programs, and firewalls, are
closed or disabled for computers running Windows.

e  The printerisinstalled on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration page, and enter the IP
address manually in the installation program. For more information, see Network configuration page

onpage 112.

Though it is not recommended that you assign a static IP address to the printer, you might resolve some
installation problems (such as a conflict with a personal firewall) by doing so. See Communication failures
between computer and printer on page 108

Network port created does not match printer IP address (Windows)

If you are using a computer running Windows, make sure that the network ports created in the printer driver
match the printer's IP address.

1. Print the printer’s network configuration page.
2. Click Start, point to Settings, then click Printers or Printers and Faxes.
—or—
Click Start, click Control Panel, then double-click Printers.
3. Right-click the printericon, click Properties, and then click the Ports tab.
4.  Select the TCP/IP port for the printer, and then click Configure Port.

5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed on the
network configuration page. If the IP addresses are different, change the IP address in the dialog box to
match the address on the network configuration page.

6.  Click OK twice to save the settings and close the dialog boxes.

Wireless network issues
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1. Make sure the wireless (802.11) light at the top left of the front panel is turned on .

If the blue light is not lit, the wireless capabilities may not have been turned on. To turn on wireless, tap
k f}] then Settings > Wireless > On.

2. Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet cable
turns off the printer's wireless capabilities.
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3. Restart components of the wireless network.

Turn off the router and the printer, and then turn them back on in this order: router first and then the
printer. If you still are unable to connect, turn off the router, printer, and your computer. Sometimes, turning
off the power and then turning it back on can solve a network communication issue.

4. Run the Wireless Network Test.

For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test page, tap
{‘-'flll then Settings > Print Wireless Network Test. If a problem is detected, the printed test report includes

recommendations that could help to solve the problem.

Advanced wireless network troubleshooting

If you have tried the above suggestions and are still unable to connect to your printer to the wireless network, try
the following:

1. Make sure that your computer's wireless networking has been turned on. For more information, see the
documentation that came with your computer.

2. Ifyou are not using a unique network name (SSID), then it is possible that your computer could be
connected to a nearby network that is not yours. The following steps can help you to determine whether
your computer is connected to your network.

Windows

a.  Click Start, click Control Panel, point to Network Connections, then click View Network Status and
Tasks.

—or—

Click Start, then Settings, click Control Panel, double-click Network Connections, click the View menu,
then select Details.

Leave the network dialog box open while you continue to the next step.

b.  Disconnect the power cord from the wireless router. The connection status of your computer should
change to Not Connected.

€.  Reconnect the power cord to the wireless router. The connection status should change to Connected.

Mac 0S X

A (lick the AirPort icon in the menu bar at the top of the screen. From the menu that appears, you can
determine if the AirPort is turned on and which wireless network your computer is connected to.

%" TIP:  For more detailed information about your AirPort connection, click System Preferences in the
Dock, then click Network. If the wireless connection is working correctly, a green dot appears next to
AirPort in the list of connections. For more information, click the Help button in the window.

If you are unable to get your computer connected to your network, contact the person who set up your
network or the router manufacturer as there may be a hardware issue with your router or computer.

If you are able to access the Internet and are using a computer running Windows, you can also access
HP Network Assistant at http://www.hp.com/sbso/wireless/tools-setup.html? jumpid=req_R1002_USEN
for help in setting up a network (this website is available in English only).

3. Print the printer's Wireless Configuration page (see Network configuration page on page 112). After the
page has been printed, check the Network Status and URL. The Network Status is Ready if the printer is
actively connected to a network, or Offline if it is not (in the latter case, run the Wireless Network Test). The
URL is the network address assigned to the printer by your router; you need it to connect to the printer's
Embedded Web Server.
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4.  If you have established that the computer and the printer both have active connections to a network, you
can check whether they are on the same network by trying to access the printer's Embedded Web Server
(see Access the Embedded Web Server on page 24).

5. If you cannot access the Embedded Web Server and are sure that both the computer and printer have
active connections to the same network, the firewall security software could be blocking communication.
Temporarily turn off any firewall security software running on your computer, and try to access the
Embedded Web Server again. If you can access it, try using the printer for printing.

If you are able to access the Embedded Web Server and use your printer with the firewall turned off, you
need to reconfigure your firewall settings to allow the computer and printer to communicate with each
other over the network.

If you are able to access the Embedded Web Server, but are still unable to use the printer even with the
firewall turned off, try enabling the firewall software to recognize the printer.

6.  If you have the HP software installed, you can check the printer’s status from your computer to check
whether the printer is paused or offline, preventing you from using it.

Windows

a.  Click Start, point to Settings, then click Printers or Printers and Faxes.
—or—
Click Start, click Control Panel, then double-click Printers.

b.  If the printers on your computer are not being displayed in Details view, click the View menu, then
click Details.

¢. Do one of the following, depending on the printer status:
e If the printer is Offline, right-click the printer, and click Use Printer Online.
e |f the printer is Paused, right-click the printer, and click Resume Printing.

d.  Tryusing the printer over the network.

Mac 0S X

a.  Click System Preferences in the Dock, then click Print & Fax.

b.  Select the printer, then click Print Queue.

c. If Jobs Stopped appears in the resulting window, click Start Jobs.

7. Ifyouinstall the HP software a second time, the installer may create a second version of the printer driver
in your Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or connecting to
the printer, make sure the correct version of the printer driver is set as the default.

a.  Click Start, point to Settings, then click Printers or Printers and Faxes.
—or—
Click Start, click Control Panel, then double-click Printers.

b.  Right-click the printer icon, and then click Properties, Document Defaults, or Printing Preferences.
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¢.  Onthe Ports tab, look for a port in the list with a checkmark. The version of the printer driver that is
connected wirelessly has Standard TCP/IP Port as the Port description, next to the checkmark.

d. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and click
Set as Default Printer.

8.  Tryrestarting the HP Network Device Support service (Windows only).
a. Delete any print jobs currently in the print queue.
b.  Onthe desktop, right-click My Computer or Computer, then click Manage.
c.  Double-click Services and Applications, then click Services.
d.  Scroll down the list of services, right-click HP Network Devices Support, then click Restart.
e.  After the service restarts, try using the printer over the network again.
If you are able to use the printer over the network, your network setup was successful.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, your firewall may
be interfering, or there may be a problem with your network configuration or router. Contact the person who set
up your network or the router manufacturer for help.

Add hardware addresses to a wireless access point (WAP)

MAC filtering is a security feature in which a WAP is configured with a list of MAC addresses (also called “hardware
addresses”) of devices that are allowed to gain access to the network through the WAP. If the WAP does not have
the hardware address of a device attempting to access the network, the WAP denies the device access to the
network. If the WAP filters MAC addresses, then the printer's MAC address must be added to the WAP's list of
accepted MAC addresses.

1. Print the network configuration page. For more information, see Network configuration page on page 112.

2. Open the WAP’s configuration utility, and add the printer’s hardware address to the list of accepted MAC
addresses.

Mobile Printing issues

For any issues with HP ePrint, visit HP Connected: http://www.hpconnected.com (availability varies by product,
country, and region).

Network configuration page

If the printer is connected to a network, you can print a network configuration page to view the network settings
for the printer. You can use the network configuration page to help troubleshoot network connectivity problems.
If you need to call HP., it is often useful to print this page before calling.

To print the network configuration page from the front panel: tap , then Internal Prints > User Information

Prints > Network Configuration Page.
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General Information: Shows information about the current status and active connection type of the
network, and other information, such as the URL of the Embedded Web Server.

802.3 Wired: Shows information about the active wired network connection, such as the IP address, subnet
mask, default gateway, and hardware address of the printer.

802.11 Wireless: Shows information about your wireless network connection, such as the hostname, IP
address, subnet mask, default gateway, and server.

Miscellaneous: Shows information about more advanced network settings.

° Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary TCP/IP
port on the printer is the default port for printing. It is accessed by HP software (for example, the
HP Standard Port).

e  LPD:Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer
spooling services that may be installed on various TCP/IP systems.

[17? NOTE: The LPD functionality can be used with any host implementation of LPD that complies with
the RFC 1179 document. The process for configuring printer spoolers, however, might differ. See your
system documentation for information about configuring these systems.

e Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are typically used on
small networks for IP address and name resolution (through UDP port 5353), where a conventional
DNS server is not used.

e  SLP:Service Location Protocol (SLP) is an Internet standard network protocol that provides a
framework to allow networking applications to discover the existence, location, and configuration of
networked services in enterprise networks. This protocol simplifies discovery and use of network
resources such as printers, Web servers, fax machines, video cameras, file systems, backup devices
(tape drives), databases, directories, mail servers, and calendars.

e  Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery (WS
Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported on the
printer. Disable unused print services to prevent access through those services.

[17? NOTE:  For more information about WS Discovery and WSD Print, visit http://www.microsoft.com/.

e  SNMP: SNMP (Simple Network Management Protocol) is used by network management applications
for device management. The printer supports SNMPv1 protocol on IP networks.

e  WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on your network, the printer
automatically obtains its IP address from that server and registers its name with any RFC 1001 and
1002-compliant dynamic name services as long as a WINS server IP address has been specified.

Connected PC(s): Lists the computers connected to this printer, as well as the last time these computers
accessed the printer.
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15 Troubleshooting general printer issues

° Printer does not start

° Printer does not print

° Printer seems slow

° Front panelis frozen

e  (annot access the Embedded Web Server

° Alerts
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Printer does not start

If the printer does not start (the front panel is blank), hold down the Power key for a few seconds and check
whether the Power LED turns orange while the key is held down.

If you see no orange light, no power is reaching the printer; check that the power cord is correctly plugged
in. If the problem persists, call HP Support (see HP Customer Care on page 119) and explain that you have
a problem with the power supply.

If you see the orange light, wait for the printer to make a beeping sound.
—  Three beeps or no beeps means that the front panel is broken; call HP Support and explain.

—  Onelong beep means an electronic problem; call HP Support and explain.

Printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file
you have sent from your computer may not start printing when expected:

You may have an electrical power problem. If there is no activity at all from the printer, and the front panel
does not respond, check that the power cord is connected correctly and that there is power available at the
socket.

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this
case, turn off the printer using the Power key on the front panel and unplug the power cord, wait until the
electromagnetic environment has returned to normal, then turn it on again. If you still experience
problems, contact your customer service representative.

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

If you are printing on a sheet, you must specify Printer Autoselect or Single-Sheet or Multi-Sheet Tray as
the paper source in your printer driver.

Printer seems slow

Here are some possible explanations:

ENWW

Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.

Did you specify the correct paper type when loading the paper? Some paper types require more time for
printing; for example, photo and coated papers require more drying time between passes. To find out the
printer's current paper type setting, see View information about the paper on page 37.

If your printer is connected by network, check that all components used in the network (network interface
cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from
other devices on the network?

If your printer is connected by USB, make sure that the USB host controller and the USB hubs used (if any)
are USB 2.0; and check that the USB cables are USB 2.0 certified.

If your printer is using a wireless network connection, try using a wired network or USB connection.

Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.
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Front panel is frozen

If the front panel displays a fixed image and you are unable to use it, call HP Support (see HP Customer Care
on page 119).

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 24.

[%/’”r NOTE: If you connect directly to your printer with a USB cable, you cannot access the Embedded Web Server.

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check
the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced
button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.

In Safari for Mac 0S X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button.
Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not
used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Alerts

Your printer can communicate two types of alerts:

Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer
driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is
able to print.

Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or for a
possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system:

Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a warning,
it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear
when the printer becomes idle and there is not another more severe alert.

Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer
status. If there is an alert in the printer, the status shows the alert text.

Driver: The driver shows alerts. The driver warns about job configuration settings that may produce a
problem in the final output. If the printer is not ready to print, it displays a warning.

HP Utility: If the HP Utility is installed, alerts can be automatically displayed under Windows and Mac 0S X: a
new panel opens on your screen with a list of alerts for each printer. This display of alerts can be activated
under Mac 0S X through the HP Printer Monitor, on under Windows by the Alerts Settings in the

HP DesignJet Utility. You can also see the list of active alerts in the Overview tab of the HP DesignJet Utility
for Windows.

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) as
displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job from
completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions
to achieve your required result.

[%f’ NOTE: There are environments that do not support bidirectional communication. In those cases, alerts do

not reach the job owner.
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Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, follow the

advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if the
recommended action does not seem to solve the problem, contact HP Support. See Contact HP Support

on page 122.

Table 16-1 Text messages

Message

Recommendation

[Color] cartridge has expired

Replace the cartridge. See Replace an ink cartridge on page 65.

[Color] cartridge is low on ink

Ensure that you have a new cartridge of the same color ready.

[Color] cartridge is very low on ink

Ensure that you have a new cartridge of the same color ready.

Depleted cartridges must be replaced to resume printing

Replace the cartridges as needed. See Replace an ink cartridge
on page 65.

Ink system failure

Contact HP Support. See Contact HP Support on page 122.

Maintenance 1 advised

Contact HP Support. See Contact HP Support on page 122.

Maintenance 2 advised

Contact HP Support. See Contact HP Support on page 122.

Maintenance 3 advised

Contact HP Support. See Contact HP Support on page 122.

One or more cartridges appear to be missing or damaged

Insert cartridges of the correct color as needed. See Replace an ink
cartridge on page 65.

Paper jam

See Roll has jammed on page 88 or Multi-sheet tray has jammed
on page 90.

Paper width is smaller than the minimum size supported by the
selected paper source. Load cancelled.

Remove the paper and load paper of the correct size.

Loaded paper is too wide. Manual unload required.

Remove the paper manually and load paper of the correct size.

Paper too far from lateral load line. Please try again.

Remove and reload the paper.

Please manually unload roll paper and try again.

Rewind the roll manually.

Single sheet is loaded with too much skew. Press Eject to unload
paper.

Remove and reload the paper.

The current job has been cancelled because the roll is out of paper.
Load the roll and send the job again.

Load a new roll.

You are printing a multipage job. Load another sheet to continue
printing or cancel the job.

Load another single sheet.

Multi-sheet tray is out of paper. Load paper in multi-sheet tray and
press OK to continue printing or cancel the job.

Load paper into the multi-sheet tray.

End of roll has been reached. It is not possible to load the roll.

Load a new roll.
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Table 16-1 Text messages (continued)

Message

Recommendation

Missing or failed printhead.

Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead. See
Replace the printhead on page 71.

NOTE: The error message does not permit returning to the home
screen to start the printhead replacement. Instead, press Show
more.

Refilled or depleted cartridge detected

Check the cartridge.

Used cartridges might not have enough ink to complete startup.
Open ink door to replace the cartridges.

A new printhead has been inserted without a new set of ink
cartridges. Replace the cartridges not marked as new. See Replace
an ink cartridge on page 65.

Wrong file format.

The file format is incorrect or not supported. The printer cannot
process the job, which will be discarded.

Out of memory.

The printer cannot complete the job. Resend the job, selecting Send
job as bitmap in the driver: go to the Advanced tab, then Document
options > Printer features.

Table 16-2 Numerical error codes

Error code Recommendation

01.1:10 Restart the printer.

02:10 There may be a paper or carriage jam. Check and clear the paper path if necessary.

03.0:10 The battery of the real-time clock has expired; contact HP Support. See Contact HP Support

on page 122.

08:10,11:10,17:10

Restart the printer.

21:10

There may be a paper or carriage jam. Check and clear the paper path if necessary.

21.1:10

Restart the printer.

41:10,41.1:10, 42:10, 42.1:10,
45:10

There may be a paper or carriage jam. Check and clear the paper path if necessary.

51.1:10, 55:10

Restart the printer.

79:04

Restart the printer. If the problem persists, update the firmware. See Firmware update on page 77.

85.1:10, 85.2:10

Restart the printer.

87:10

There may be a paper or carriage jam. Check and clear the paper path if necessary. Also clean the
carriage encoder strip; see Clean the encoder strip on page 76.
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HP Customer Care

° Introduction

° HP Professional Services

° HP Proactive Support

° Customer Self Repair

° Contact HP Support
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Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing
comprehensive, proven support expertise and new technologies to give you unigue end-to-end support. Services
include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone
and Web support, software updates and self-maintenance services. To find out more about HP Customer Care,
please visit us at http://www.hp.com/go/graphic-arts or call us on the telephone (see Contact HP Support

on page 122).

¥ TIP: By taking just a few minutes to register, you can improve your experience with HP and enjoy more efficient
support. Click http://register.hp.com/ to start. Also click http://www.hp.com/go/alerts to get connected with
DesignJet updates, including product fixes and enhancements.

HP Professional Services

HP Support Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your
HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24x7 access to:

e  Multimedia tutorials

e  Step-by-step how-to guides

e  Downloads: the latest printer firmware, drivers, software, etc.

e  Technical support: online troubleshooting, customer care contacts and more

e  Workflows and detailed advice for completing various printing tasks from particular software applications
e  Forums for direct contact with the experts, both HP and your colleagues

e  Warranty tracking online, for your peace of mind

e  Latest product information: printers, supplies, accessories, software, etc.

e  Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/T120/support or http://www.hp.com/qo/T520/
support.

By customizing your registration for the products you have purchased and your type of business, and by setting
your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and
documentation.

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time
options:

e  Next business day

e  Same business day, within four hours (may not be available in all countries)
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For more information on HP Care Packs, visit http://www.hp.com/go/printservices.

HP Installation
The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, visit http://www.hp.com/go/printservices.

HP Proactive Support

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and resolving
printer issues before they become problems for you. HP's Proactive Support tool is designed to help businesses
of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your
printing environment—with a clear focus on maximizing the value of your investment, increasing printer uptime
and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before
they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware
updates.

You can enable Proactive Support in the HP DesignJet Utility for Windows or the HP Printer Monitor for Mac OS X,
where you can specify the frequency of connections between your computer and HP's Web server, and the
frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change these
settings:

e Inthe HP DesignJet Utility for Windows, click the Tools menu, then HP Proactive Support (not available in
HP DesignJet Utility 1.0).

e  Inthe HP Printer Monitor for Mac OS X, click Preferences > Monitoring > Enable HP Proactive Support.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and
recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be
asked to perform some procedure to solve the problem.

Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It
enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this
program, you can replace parts at your own convenience.

Convenient, easy to use

e  AnHP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

e  Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact
HP.

e  Available for most HP products currently under warranty or contract.
e  Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.
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Contact HP Support

HP Support is available to you by telephone. What to do before you call;

e  Review the troubleshooting suggestions in this guide.

e  Review the relevant driver documentation.

e [fyou have installed third-party software drivers and RIPs, see their documentation.

e [fyou call one of the HP offices, please have the following information available to help us answer your
guestions more quickly:

—  The product you are using (the product number and the serial number, found on the label at the back
of the product)

— Ifthereis an error code on the front panel, note it down; see Front-panel error messages on page 117

—  The computer you are using

—  Any special equipment or software you are using (for example, spoolers, networks, switch-boxes,
modems or special software drivers)

—  The cable you are using (by part number) and where you purchased it
—  The type of interface used on your product (USB, network, or Wi-Fi)
—  The software name and version you are currently using

—  If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report and “all pages above” from Service Information (see The
printer’s internal prints on page 11)

Telephone number

Your HP Support telephone number is available on the Web: visit http://welcome.hp.com/country/us/en/
wwecontact us.html.
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18 Printer specifications

° Functional specifications

° Mobile Printing specifications

° Physical specifications

° Memory specifications

° Power specifications

° Ecological specifications

° Environmental specifications

e  Acoustic specifications
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Functional specifications

Table 18-1 HP 72 ink supplies

Printhead

One printhead

Ink cartridges

Cartridges containing 29 ml of ink: yellow, magenta, and cyan
Cartridges containing 38 ml of ink: black

Cartridges containing 80 ml of ink: black

Table 18-2 Paper sizes

Minimum Maximum
Roll width 279 mm (11 in) 610 mm (24 in) or 914 mm (36 in)
Roll length 46 m (150 feet)
Roll diameter 100 mm (3.9in)
610 mm (24 in) roll weight 4.1kg (91b)
914 mm (36 in) roll weight 6.2 kg (14 1b)

Sheet width

210 mm (8.27 in) 610 mm (24 in) or 914 mm (36 in)

Sheet length

279 mm (171n) 1676 mm (66 in)

Paper thickness

0.3mm (0.011n)

Paper weight

60 g/m2 280 g/m2 (220 g/m2 in multi-sheet tray)

Table 18-3 Printing resolutions (T120)

Print quality Maximum detail Rendering resolution (ppi) Printing resolution (dpi)
Best (glossy paper*) On 600 x 600 1200 x 1200
Off 600 x 600 1200 x 1200
Best (other papers) Off 600 x 600 1200 x 1200
Normal Off 600 x 600 1200 x 1200
Fast Off 300 x 300 1200 x 1200
Econofast Off 300 x 300 1200 x 1200
Table 18-4 Printing resolutions (T520)
Print quality Maximum detail Rendering resolution (ppi) Printing resolution (dpi)
Best (glossy paper*) On 1200 = 1200 2400 x 1200
Off 600 x 600 1200 x 1200
Best (other papers) Off 600 x 600 1200 = 1200
Normal Off 600 x 600 1200 x 1200
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Table 18-4 Printing resolutions (T520) (continued)

Print quality Maximum detail Rendering resolution (ppi) Printing resolution (dpi)
Fast Off 600 x 600 1200 x 1200
Econofast Off 600 x 600 1200 x 1200

* For a list of supported glossy papers, see Order paper on page 80.

Table 18-5 Margins

Top, bottom, right, and left margins 5mm (0.2 in)

Table 18-6 Mechanical accuracy

+0.1% of the specified vector length or 0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AQ printing material

in Best or Normal mode with HP Matte Film roll feed.

Table 18-7 Graphic languages supported

HP DesignJet Languages
T120 HP PCL3GUI
7520 HP PCL3GUI (Mac 0S X), HP-GL/2 and HP RTL (Windows)

Mobile Printing specifications

ENWW

Table 18-8 Mobile direct printing

Software i0S with AirPrint, or Android with HP Print Service Plugin
Mobile devices supported Smartphones and tablets

Operating systems supported i0S from 7.0, Android from 4.4, any version of Windows
Connectivity requirements Printer and mobile device must use the same network
File formats supported PDF, JPEG

Table 18-9 Email printing

Software HP ePrint

Mobile devices supported Smartphones, tablets, computers
Operating systems supported Any system with email capability
Connectivity requirements Cloud connection

Cloud features Remote printing through email
File formats supported PDF, JPEG, TIFF

Maximum file size 10MB
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Table 18-10 HP All-in-One Remote printing

Software

HP All-in-One Printer Remote

Mobile devices supported

Smartphones, tablets

Operating systems supported

i0S from 7.0, Android from 4.4

Connectivity requirements

Printer and mobile device must use the same network

File formats supported

PDF, JPEG, webpages, email attachments, Microsoft Office documents

Physical specifications

Table 18-11 Printer physical specifications

HP DesignJet T120 HP DesignJet T520 24-in HP Designlet T520 36-in

Weight 25.5kg (56.2 lb) 35kg (77.21b) 39kg (86.0lb)

Width 987.2 mm (38.87 in) 987.2 mm (38.87 in) 1287 mm (50.67 in)

Depth Minimum: 527 mm (20.7 in) Minimum: 527 mm (20.7 in) Minimum: 527 mm (20.7 in)
Maximum: 896 mm (35.3 in) Maximum: 896 mm (35.3 in) Maximum: 896 mm (35.3 in)

Height Minimum: 275 mm (10.8 in) Minimum: 936 mm (36.9 in) with stand ~ Minimum: 936 mm (36.9 in) with stand

Maximum: 502 mm (19.8 in)

Maximum: 1155 mm (45.47 in) with
stand and multi-sheet tray extended

Maximum: 1155 mm (45.47 in) with
stand and multi-sheet tray extended

Memory specifications

Table 18-12 Memory specifications

HP DesignJet Memory
T120 256 MB
T520 1GB

Power specifications

Table 18-13 Printer power specifications

Source 100-240V ac +10%, auto-ranging
Frequency 50/60 Hz

Maximum current 1200 mA

Average consumption 35W

Ecological specifications

This product complies with the WEEE Directive 2002/96/EC and RoHS Directive 2002/95/EC. To determine the
ENERGY STAR qualification status of these product models, see http://www.hp.com/go/energystar.
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Environmental specifications

Table 18-14 Printer environmental specifications

Operating temperature

5 to 40°C (41 to 104°F)

Recommended operating temperature

15 to 35°C (59 to 95°F), depending on paper type

Storage temperature

—251055°C(~13 to 131°F)

Recommended operating humidity

20 to 80% RH, depending on paper type

Storage humidity

0to 95% RH

Acoustic specifications

Printer acoustic specifications (declared according to ISO 9296).

Table 18-15 Printer acoustic specifications

Idle sound power level <3.4B(A)
Operating sound power level 6.5 B (A)
Idle sound pressure at bystander position <16 dB (A)
Operating sound pressure at bystander position 48 dB (A)
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Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a
particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of
the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the
printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to
minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the
printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink cartridges). Additionally, to
reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body
movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Fast Ethernet
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable of
negotiating slower speeds when required for compatibility with older Ethernet devices.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with
original USB. Most personal computers today use Hi-Speed USB.
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HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

I/0
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec

A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes
on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware
whether IPSec is being used or not.

IPv4 address
A unigue identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated
by full stops. Most networks in the world use IPv4 addresses.

IPv6 address

A unigue identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the
world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unigue identifier used to identify a particular device on a network. It is a lower-level identifier
than the IP address. Thus, a device may have both a MAC address and an IP address.

Network

A network is a set of connections that pass data between computers and devices. Every device is able to communicate with
every other device in the same network. This allows data to be moved between computers and devices, and allows devices
such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped,
dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it
on the paper, through a cluster of nozzles.

Spindle
Arod that supports a roll of paper while it is being used for printing.
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TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed USB
(sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to your
printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.

WiFi
This term is used for any wireless local area network products that are based on the Institute of Electrical and Electronics
Engineers' (IEEE) 802.11 standards.
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